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1. INTRODUZIONE

La MicroBlaze and Multimedia Demo Board é una piattaforma orientata allo sviluppo di
applicazioni multimediali prodotta dalla Xilinx. 1l suo nucleo é costituito da un FPGA Virtex2
interfacciabile con un gran numero di periferiche integrate direttamente sulla board quali ingressi e
uscite video PAL o NTSC, ingressi e uscite audio, porta ethernet, true color VGA, interfacce PS2 e
RS232, cinque blocchi di RAM esterna di tipo ZBT da 512 kilobytes I'uno, due led. Sono presenti
inoltre degli switch e dei tasti che possono essere configurati per interagire con il sistema. Il
controller SystemACE permette infine di caricare direttamente il sistema da una memoria di tipo
CompactFlash.

Il software utilizzato per lavorare con la MultiMedia Board é I'Embedded Development Kit 6.1i; per
funzionare correttamente esso necessita della presenza dell’Integrated System Environment 6.1i,
di cui utilizza le funzioni di sintetizzazione e implementazione dell’hardware. Entrambi i programmi
necessitano dei rispettivi Service Packs per operare correttamente.

L'Embedded Development Kit € un ambiente di sviluppo prodotto dalla Xilinx che permette di
integrare il design di hardware e software nello stesso progetto. Esso € orientato alla generazione
di sistemi che incoroporano al loro interno un soft processor chiamato MicroBlaze, che pud essere
poi programmato in assembler, in C o in C++, utilizzando eventualmente le librerie fornite dal
produttore.

L’EDK permette di implementare su FPGA progetti anche molto complessi dandoci la possibilita di
utilizzare e interfacciare fra loro dei cores gia pronti o importarne di nuovi.

| passi fondamentali della realizzazione di un progetto sono:

o scelta dei cores necessari (fra cui il MicroBlaze) e configurazione dei loro parametri;

o definizione dei segnali che permettono alle varie periferiche interne al’FPGA di comunicare
tra loro;

o definizione dei segnali e delle porte che permettono allFPGA di comunicare con l'esterno;

o sintetizzazione dell'hardware (creazione della netlist e del bitstream);

. scrittura del codice da far eseguire al MicroBlaze;

o generazione delle librerie software necessarie e compilazione del codice (con eventuale
debugging)

) aggiornamento del bitstream con I'eseguibile per il Microblaze;

o download del bitstream finale su FPGA.

Nel presente tutorial affronteremo tutti i passi della realizzazione di un progetto per la Multimedia
Board con 'EDK.

Il primo esempio consistera nella realizzazione di un sistema che scriva sulla porta RS232,
connessa al nostro computer, il classico “Hello World!”; vedremo tutti gli stadi della realizzazione
del’hardware e del software e un piccolo approfondimento sulle diverse librerie utilizzabili per
programmare il MicroBlaze.

Il secondo esempio sara un sistema poco pil complesso del precedente, a cui connetteremo in piu
degli switch e dei led.

Il terzo esempio sara piu impegnativo, dovremo far girare I”Hello world!” dalla ram esterna;
coglieremo l'occasione per vedere come importare un core scritto in VHDL o Verilog nel’lEDK e
come effettuare il debugging del software.

Del quarto progetto, la realizzazione di un’infrastruttura per I'elaborazione video in tempo reale,
vedremo soltanto una descrizione sul suo funzionamento e non la spiegazione di tutta la sua
creazione, data la sua complessita.



2. IL PRIMO PROGETTO: HELLO WORLD!

Il primo progetto consiste nel programmare 'FPGA in modo da inviare dei caratteri ASCII sulla
porta seriale del nostro computer, sul quale avremo abilitato un’interfaccia di tipo terminale (ad
esempio HyperTerminal di Windows); si tratta in pratica del classico “Hello world!” che si prende
spesso come primo esempio di programmazione per imparare un nuovo linguaggio.

Nel nostro caso dovremo perod creare anche I’hardware necessario a far girare il nostro codice, che
sara poi scritto in linguaggio C.

Sebbene sia sempre difficile effettuare una distinzione netta fra hardware e software, e nel nostro
caso é forse anche improprio, esso puo facilitare la comprensione della metodologia di lavoro con
'EDK: intenderemo quindi hardware quando si tratta di connettere i cores e sintetizzare i rispettivi
codici VHDL; chiameremo invece software il codice C da far eseguire al MicroBlaze.

Nello stadio finale del nostro progetto, perd, non dovremo piu considerare questa distinzione, in
quanto cid che scaricheremo sullFPGA sara un semplice bitstream ricavato dall’'unione delle due
parti.

Nell'archivio helloworld.zip é contenuto il progetto completo e funzionante.

2.1 PROGETTARE L’HARDWARE

Il sistema che vogliamo creare é costituito dai seguenti componenti:
e un soft processor MicroBlaze;
una memoria di tipo block RAM in cui possano risiedere dati e codice eseguibile;
un controller per la parte dati della block RAM;
un controller per la parte istruzioni della block RAM,;
un’interfaccia di tipo JTAG tramite cui scaricare il bitstream su FPGA e eventualmente
eseguire il debugging del codice eseguibile;
e un’interfaccia di tipo UART che inviera i dati al nostro computer tramite la porta RS232.

| dispositivi comunicano con il MicroBlaze tramite:
e due local bus, uno per la parte dati e uno per la parte istruzioni della RAM,;
¢ un OPB (on-chip peripheral bus) per gli altri dispositivi.

Dal menu del’EDK 6.1 caricare il programma Xilinx Platform Studio, I'interfaccia tramite cui seguire
i vari passi della progettazione e dellimplementazione, fino alla conversione in bitstream e al
download su FPGA.

2.1.1 CREARE UN NUOVO PROGETTO
Cliccare su File -> New Project -> Platform Studio...

L’opzione Base System Builder avrebbe permesso di generare un sistema in maniera automatica,
potendo configurare facilmente i componenti pit comuni secondo le nostre esigenze, ma allo stato
attuale la MultiMedia Board non é supportata.

Definire la directory di lavoro desiderata e selezionare il tipo di FPGA su cui sara implementato |l
design, i campi corretti sono indicati in figura.

E’ importante ricordare sempre che il percorso della cartella in cui € situato il nostro progetto non
pud contenere spazi o caratteri particolari (come lettere accentate) altrimenti i files non potranno
essere trovati dagli script che vengono fatti eseguire tramite il Platform Studio.
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Prima di tutto dobbiamo scegliere i cores che compongono I'hardware del nostro sistema.
Cliccare su MHS File: system.mhs con il tasto destro del mouse e scegliere Add/Edit Cores.
Apparira un’interfaccia che ci permette di scegliere e configurare i dispositivi.



2.1.2 IL MENU’ PERIPHERALS

Il primo passo é definire i componenti che costituiscono il sistema e i rispettivi indirizzi di memoria.
Configurare come in figura.

Add/Edit Hardware Platform Specifications B‘
Peripherals lEIus CDnnedions] Ports ] Parameters]

E‘ia Cells with white backgrounds can be edited.

Ed Tao delete peripherals, choose one or mare rows and click Delete. Ch_oose ane ormare ”_33 {uze ctrl and
shift far multiple selections) from the
Peripheral [Hw ver  |Instance | Base Address |Hgh Address  [Min lizt below and click Add
microblaze 200.a = |micrcblaze - opb2aes bridgs =
bram_block 1.00.a bram opbzplb_bridge
ophb_arhiter
Imb_brarm_if ... | 1.00.b bram_data_ctrl Q00000000 | 00000 1FFF OxB00 opb_atmc

. A ophb_brarm_if_cntlr
Imb_bram_if_... | 1.00.b _bram_mst_ctrl Q00000000 | 00000 1FFF 0xB00 opb_cartral dma

opb_jtag_uart | 1.00b jtag OxFFFFE000  OxFFFFBOFF o oph_care_mspl

: opb_core_ssp_ref
opb_uartiite 1.00.b Lart OxFFFFQ000 | OxFFFFSOFF 0100 oph_core_ssp_ref

ophb_ddr
opb_emc
opb_ethernet
ophb_sthernetlite
opb_gpio
ophb_hdlc

Delete »> @ DpE_iict
opb_intc

oph_jtag_uart
opb_mdm
opb_memcan
opb_oph_lite
ophb_pci
opb_pci_arhiter
opb_sdram
ophb_spi
oph_sysace
oph_timebase_wdt
oph_timer
opb_uart1 8550
ophb_uartlite
opb_zbt_controller M

QK | Annulla | Applica l

Le indicazioni sugli indirizzi dei controller della BRAM indicano quanto sara grande la memoria;
essi sono specificati in esadecimale quindi il nostro sistema avra 8 kilobytes di BRAM; é
fondamentale che la sua dimensione sia adeguata alla quantita di dati e istruzioni che deve
contenere.

Scrivendo all'indirizzo specificato per la UART, invece, invieremo dati tramite la porta RS232.

Cliccando su Applica viene modificato il file MHS (Microprocessor Hardware Specification) in cui
sono indicati i nomi dei componenti, i loro collegamenti e la configurazione dei loro parametri [1].



2.1.3 IL MENU’'BUS CONNECTIONS

Cliccando su Bus Connections accediamo all'interfaccia per gestire i collegamenti fra le varie
periferiche che comunicano con il MicroBlaze tramite bus. Come si pud vedere in figura il
MicroBlaze fungera da Master per:

e il data local memory bus, a cui é collegata la BRAM,;
e [instructions local memory bus, anch’esso collegato alla BRAM,;
e ['OPB bus, a cui verranno connesse la UART e la JTAG.

Sempre nella stessa schermata vanno collegate le due porte della BRAM ai rispettivi controllers.

Add/Edit Hardware Platform Specifications Bl

Feripherals Bus Connections lPDr‘tS ] Parameters]

Click on squares to make master. slawve or master-slawe (M. 5. MES) connections. Choose one or more (using shiftand Ctrl)
Fight click on any bus instance (column header) for a context menu. buses and click Add.
2
A8 5% dor v28_w1_00_m A

o) L dsocm_w10_w1_00_a

mhblaze dimb M dsocm_w10_w1_00_h
fgl_w20_w1_00_h
; << Add SE Ao s

mhlaze ilmh H isocm_w10_v1_00_a
mblaze dophb [l isocm_v10_1_00_h w
rblaze ioph M Choose the BRAM portto connectto the contraller por.
T 5 Give aname ta the connection.
bram_inst_ctl slmh | S Cntlr Port BRAM Port |Comector |
jtag sopb 5 bram_data_ctrl bram_port  |bram PORTA ﬂ porta
uart saph = bram_inst_ctrl bram_port | bram PORTE ﬂ porth

OK. | Annulla Applica




2.1.4 IL MENU’PORTS

Il passo successivo consiste nel definire i segnali tramite cui comunicheranno i vari IP che
verranno implementati nellFPGA e le porte tramite cui 'TFPGA comunichera con l'esterno.

Il clock entra tramite la porta MASTER _CLOCK_P e viene quindi distribuito fra i vari dispositivi
sulla rete clk_27mhz.

Lo stesso discorso vale per TEXTEND _DCM_RESET_P che viene distribuito internamente su
foga_reset.

Le porte di comunicazione RX e TX della UART vengono portate direttamente all’esterno senza
passaggi intermedi in quanto interessano un solo dispositivo (tuttavia potevano essere create delle
porte esterne anche per esse senza comportare alcuna differenza).

In realta avremmo potuto collegare direttamente anche tutti i segnali di clock e di reset all’esterno
senza creare le due porte aggiuntive, ma il nostro progetto risulta in questo modo piu pulito.

Se i segnali esterni fossero stati dei vettori avremmo dovuto indicare il loro numero o intervallo nel
campo Range.

Add/Edit Hardware Platform Specifications @

Peripherals ] Bus Connections Forts l Farameters ]
Fort Signal Assignments. Filter substring or instance
Use ctrl and shift for multiple row selections and click Connectto connect ports. j
Use Add Port for external ports that need to be GND or YCC.
The "Range" column for external ports is given as "[LE:UB]" (for e.g.[0:31]) List of Ports. Select one or more
ports and Click Add
Instance | Port Mame Met Name |Pol... | scope |Ra. |Class | sensit.. |
N
mblaze LK clk_27mhz i Internal ﬂ CLK o s
bram_d... |LMB_Clk clk_27mhz I Internal ﬂ CLK CLK.
INTERRUPT
bram_in... |LMB_Clk clk_27mhz I Internal ﬂ CLK VALID INSTR
jtag OPB_Clk ck_27mhz I ntema v | TLK PC_EX
add Part | | PEGUWRITE
Lart OPB_Clk clk_27mhz I Internal ﬂ CLK REG_ADDR
MSR_REG
Lart RX RZ232_R¥_DATA P |1 External ﬂ NEW PEG_VALUE
Lart T RS232_TH_DATA P O External LJ PIPE_RLINMING
data_lmb |LMB_Clk clk_27mhz I Internal ﬂ CLE %I\E??%EE@TAKEN
data_lmb |S¥S_Rst fpga_reset 1 Internal ﬂ PREFETCH_ADDR
MB_Halted
instmb | LMB_Ck ck_z7mhz I Inemd v LK Del i
inst_lmb | SYS_Pst fpga_reset I Internal ﬂ bram
opb_bus | OFB_Clk clk_27mhz i Internal ﬂ CLK Connect | |bram_data_ctrl
opb_bus [SYS_Rst fpga_reset Ii Internal ﬂ LMB_Clk
system MASTER _CLOCK_P clk_27mhz N Extermal CLK bram_inst_ctrl
system  |EXTEND DCM RESET_P  fbga_reset N Escternal RST LMB_Clk
ftag
OPB_Clk
Interrupt
uart v
0K Annulla Applica




2.1.5IL MENU'PARAMETERS

L'ultimo menu a tendina ci permette di configurare i parametri dei vari IP, in caso avessimo
bisogno di modificare i valori di default.

Nel nostro caso dobbiamo portare a 0 il valore di C_EXT _RESET_HIGH per le istanze data_Imb,
inst_Imb e opb_bus, in quanto il segnale di reset proveniente dalla board é attivo con il valore
logico “0”.

Impostare inoltre come in figura i parametri per la UART. Essi devono corrispondere ai valori che
immetteremo nel configurare il terminale di Windows.

Add/Edit Hardware Platform Specifications

Perlphera\s] Bus Connedlnns] Parts  Farameters

Edit Parameters assigned to IF Instance in MHS Choose IF Instance for a list of parameters.

These parametervalues will override default MPD values. v Open PDF Doc
Farameters with default values fram MFED
Parameter Value Choogse one ar mare {using shift and ctrl) and click Add.
C_DATA_BITS =}
Farameter | Yalue |
C CLK FREQ 27 _000_000
c C_DATA_BITS =]
C_BAUDRATE 2500
C_CLK_FREDQ 125_000_000
C_USE_PARITY o} T
C_BAUDRATE SE00
C_0ODD_PARITY U}
s C_USE_PARITY 1
C_ODC_PARITY 1

Del

0K | Annulla Applica




2.1.6 GENERATE NETLIST

Cliccando su Tools -> Generate Netlist vengono generati i files VHDL che interconnettono tutti i
cores del sistema secondo i parametri che abbiamo fornito loro; una volta che questi sono stati
compilati e sintetizzati singolarmente viene fatto lo stesso per il top-level del progetto; abbiamo
cosi un’unica netlist globale.

2.1.7 DEFINIRE LE CONSTRAINTS

Il passo successivo € creare un file con le constraints, ossia definire i pin del’lFPGA che verranno
collegati alle porte esterne che abbiamo definito nel sistema e eventuali caratteristiche di tali porte.
Questo file si deve chiamare obbligatoriamente system.ucf e risiedere nella sottodirectory /data del
progetto.

Andando nuovamente su Add/Edit Cores e scegliendo Ports dobbiamo trovare tutte le reti che
hanno scritto External nel campo Scope e definire i pin di collegamento facendo coincidere il loro
nome con quello scritto nella colonna Net Name (RS232 TX DATA P, RS232 RX DATA P), a
meno che abbiamo creato una porta esterna (ad esempio per MASTER CLOCK P,
EXTEND_DCM_RESET _P) nel cui caso il nome sara quello definito nella colonna Port Name e il
nome dell’instance sara sempre system.

Dai datasheets o dai files forniti dalla Xilinx possiamo trovare i pin ed eventuali altri parametri da
definire per ciascun collegamento.
Nel nostro caso il file system.ucf [2] risulta:

# SYSTEM CLOCKS
NET "MASTER_CLOCK_P" LOC ="AH15";

# DCM RESET EXTENSION
NET "EXTEND_DCM_RESET_P" LOC ="AH7";

# RS232 COMMUNICATION PORT

NET "RS232_TX_DATA_P"LOC ="C9";

NET "RS232_TX_DATA_P" SLOW;

NET "RS232_TX_DATA_P" IOSTANDARD = LVTTL;
NET "RS232_TX_DATA_P" DRIVE = 12;

NET "RS232_RX_DATA_P"LOC ="C8"

2.1.7 GENERATE BITSTREAM

Cliccando su Tools -> Generate Bitstream la Netlist precedentemente ottenuta viene implementata
per la piattaforma specificata in fase di creazione del progetto e i segnali provenienti dall’esterno
vengono collegati come definito nel file system.ucf.
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2.2 IL SOFTWARE

Prima di scrivere il codice C da far eseguire al MicroBlaze dobbiamo compilare le librerie che
potranno venire utilizzate dal nostro hardware.

2.2.1 LIBRARY GENERATOR

Clicchiamo su mblaze con il tasto destro e quindi S\W Settings: definiremo qui lo standard in,
standard out e standard debug del nostro progetto. Settiamoli tutti e tre anche se per il momento
utilizzeremo soltanto lo standard out, il controller UART che inviera i dati alla porta seriale del
nostro computer.

S/W Settings - instance mblaze B‘
Optimization } Directories ] Details ] Others ]
Frocessor Property | Enviranment

Diriver Configuration

Device Driver |CPU
DriverWersion |1.00.a ~|
Interface Lewval |D ﬂ
Set Defaults
Mode
& Executable i XmdStub

Cormmunication Peripherals

STOINPeripheral — [yan ~]

STDOUT Peripheral |uart ﬂ

Diebug Peripheral |jtag ﬂ
’TI Annulla

Esistono un gran numero di librerie fornite dalla Xilinx per agevolare la programmazione dei
dispositivi con cui comunica il MicroBlaze; generalmente per ogni device ci sono due gruppi di
librerie, uno a piu basso livello, che occupa meno memoria e svolge funzioni piu semplici, e uno a
piu alto livello che é pero piu pesante [3]. Sta alle nostre esigenze per ogni specifica situazione
scegliere che tipo di librerie utilizzare. Per ora conserviamo la configurazione di default, vedremo in
seguito come scegliere le librerie da compilare.

Cliccare quindi Tools -> Generate Libraries.
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2.2.2 IL PROGRAMMA C

Come ultimo passo dobbiamo scrivere il programma C da far eseguire al MicroBlaze.
Creare un file con il nome desiderato (per esempio helloworld.c nella sottodirectory /code, ma non
vi sono restrizioni in merito, come in altri casi) con il seguente codice:

#include "stdio.h"

main() {
while( 1)

print("Hello world\n\r");
print("l am your new MicroBlaze\n\r");

Nel menu della finestra a sinistra, sotto mblaze, cliccare su Sources con il tasto destro del mouse,
quindi Add Files e infine selezionare il file creato.

2.2.3 COMPILE PROGRAM SOURCES

Compilare il file sorgente con Tools -> Compile Program Sources.

Dalla finestra di output vediamo che la dimensione del nostro programma compilato é di 1499
bytes.

2.2.4 UPDATE BISTREAM

Aggiorniamo con il codice compilato il bitstream da scaricare sul’lFPGA con il comando Tools ->
Update Bitstream.

2.3 CONFIGURAZIONE DEL SISTEMA E DOWNLOAD

Colleghiamo opportunamente i cavi di alimentazione e di programmazione del’lFPGA e inoltre un
cavo seriale per connettere le due porte RS232 di computer e board.

Per scaricare il bitstream su FPGA potremmo utilizzare iMPACT, accessorio dellISE 6.1, ma é
molto pit comodo richiamare le sue funzioni direttamente dal’EDK tramite uno script.

Creiamo un file che si deve chiamare download.cmd [4] e deve risiedere nella sottodirectory /etc

del nostro progetto.

Scriviamo al suo interno:

setMode -bscan

setCable -p Ipt1

addDevice -p 1 -file etc/systemace.bsd
assignfile -p 1 file etc/systemace.bsd
addDevice -p 2 -file implementation/download.bit
program -p 2

quit
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Il tool di download del bitstream rileva due periferiche collegate in serie; a noi interesserebbe
soltanto scaricare il download.bit sul’lFPGA (identificata come Device 2); tuttavia é preferibile
programmare sempre anche il SystemAce con l'opportuno systemace.bsd [5]: i file di tipo BSDL
servono per gestire separatamente la programmazione di periferiche connesse in cascata.
Cliccare su Tools -> Download.

Se tutto é stato effettuato a dovere il MicroBlaze ci salutera.

2.4 LE LIBRERIE XILINX

Per il primo esempio di programma abbiamo usato la libreria stdio.h, una libreria standard del C, e
la sua funzione print che scrive sullo STDOUT che abbiamo specificato nel pannello S\W Settings;
utilizziamo ora delle librerie specifiche della Xilinx per ottenere lo stesso risultato.

Per utilizzare le librerie di basso livello della porta UART non serve modificare alcun parametro nel
S\W Settings del controller perché sono impostate di default; le funzioni da richiamare sono
definite dal file xuartlite_I.h.

Per capire come utilizzarle possiamo consultare la documentazione di tutti i drivers forniti tramite
Help -> EDK Help, quindi cliccando sul link Documents e infine Xilinx Drivers.

Utilizziamo la funzione XuartLite _SendByte [6], che invia un byte di dati all'indirizzo della porta
UART; possiamo indicare direttamente [Iindirizzo di base della UART (in questo caso
OxFFFF9000) ma é piu comodo includere il file xparameters.h, generato automaticamente
dal’EDK, e indicare I'indirizzo come XPAR_UART_BASEADDR.

Cliccando su Generated Header: mblaze/include/xparameters.h (nella schermata principale
del’XPS) possiamo leggere le definizioni di tutti gli indirizzi generati, fra cui #define
XPAR_UART_BASEADDR 0xFFFF9000.

Notare che non sarebbe stato necessario indicare lo STDOUT come prima perché comunque la
funzione indirizza il byte da spedire all'indirizzo specificato e non allo standard output.

/l'low_level_lib_example.c

#include "xparameters.h"
#include "xuartlite_I.h"

main()

Xuint8 text[] = "using low level library - ";
int count = 0;
while (1)
{
count = 0;
while (count < sizeof(text))

XUartLite_SendByte(XPAR_UART_BASEADDR, text[count]);
count++;
}
}
}

Compilando il file notiamo che con questa libreria la dimensione dell’eseguibile é di 1643 bytes,
cioé leggermente superiore a quello precedente.
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Proviamo ora ad utilizzare le librerie a piu alto livello, cliccando su UART(con il tasto destro) e
quindi su S\W Settings, per accedere al Peripheral Options.

Peripheral Options g|
Peripheral Attributes
FPeripheral uart

Base Address  OxFFFFI000
High Address OxFFFFI0FF

Interrupt Handler Function

An Interrupt handler can be specified anly if the peripheral has a
port of type INTERRUFT and that portis connected in MHS.

Driver Configuration

Device Driver |uart|ite ﬂ
Driverersion |1_DD.b ﬂ
hntrfoce Level -

Connectto 05 | ﬂ

Flease view the MDD file far any other parameters to override.

MOD Farams ‘ | Default | | (0] 4 Cancel ‘

Settiamo Interface Level a 1, che corrisponde alla libreria di livello piu alto uartlite.h [7].

Prima non avevamo dovuto modificare alcun parametro per utilizzare la libreria uartlite_I.h [8], essa
€ accessibile in ogni caso, poiché anche se indichiamo uartlite.h essa stessa la include a sua volta
per richiamare le funzioni piu basilari. in pratica il sistema é costruito a livelli.

Dobbiamo impostare lo stesso livello anche per il driver della JATG; anche se in realta non lo
utilizziamo, il Library Generator lo considera comunque e, essendo lo stesso driver utilizzato dalla
UART, deve essere impostato sullo stesso livello; livelli differenti dello stesso driver non sono
supportati e cid genererebbe quindi un errore.

/[ hi_level_lib_example.c

#include "parameters.h"
#include "xuartlite.h"

main()

XUartLite uart;
XUartLite_Initialize(&uart, XPAR_UART_DEVICE_ID);
while(1)

xil_printf("using high level libraries - ");
}
}

14



La funzione xil_printf che utilizziamo qui é quindi molto piu immediata, basta indicare la stringa che
si vuole ottenere in output. L’'unico accorgimento necessario € che bisogna inizializzare la porta
con il comando XuartLite Initialize [9].

Compilando il sorgente notiamo che I'eseguibile generato é di 4433 bytes, piu del triplo di quello
precedente, a causa del diverso spessore dei driver.

Sta quindi a noi decidere in ogni occasione qual € il driver piu opportuno da utilizzare.
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3. INTERFACCIARE SWITCH E LED

Il secondo progetto riprende gran parte dell’hardware del primo. La variazione consiste
nell’aggiunta del controllo dei due led della MutiMedia Board tramite due switch.

Lo switchO é collegato a un GPIO (general purpose input output) che comunica con il MicroBlaze
sul bus OPB. A quest’ultimo é connesso un altro GPIO che comunica con il ledO. | valori di questi
due dispositivi possono essere quindi letti o scritti da un programma eseguito dal MicroBlaze.

Lo switch1, invece, é connesso direttamente con il led7, lo stato del secondo corrisponde sempre
e comunque a quello del primo e il MicroBlaze non pu0 né leggere né scrivere su alcuno dei due,
poiché fra loro esiste un collegamento puramente hardware.

Nell'archivio switchled.zip é contenuto il progetto completo e funzionante.

3.1 HARDWARE

Configuriamo il sistema come riportato nelle figure successive; aggiungiamo due istanze dell'IP
opb_gpio 1.00.a; sono presenti pure le versioni 2.00 e 3.00, ma la 1.00 € molto piu semplice
(quindi occupa meno spazio sullFPGA) e sufficiente per il nostro utilizzo.

Add/Edit Hardware Platform Specifications @
Feripherals lEIus CDnnediDns] Ports l Parametersl

EEEE Cells with white backgrounds can be edited.

i To delete peripherals, choose one or more raws and click Delete. Ch_oose cnonimiie ”.DS [iepeliond
shiftfor multiple selections) from the
Peripheral Hw ver | Instance | Base Address | High Addr... |Min l=ttleaieles Sar
microblaze 2.00.a ﬂ mblazea bram_block ~
bram_block 1.00.8 bram clock_module_ref
dom_module
Imb_bram_if_cntr 1.00.b bram_data_ctrl 000000000 | 0x00001FFF | Ox800 der_inte
- ) ddr_clock_module_ref
Imb_bram_if_crtr 1.00.b bram_inst_ctrl Ox00000000 | Ox00001FFF | OxE00 dsbrariei el
opb_jtag_uart 1.00b jtag OxFFFF3000 | OxFRFFE0FF fit_tirner
= << Add iskrarm_if_cntlr
opb_uartite 100b Lart OxFFFF9000 | OxFRFFS0FF | 0x100 ftagppc._cntlr
opb_gpio 100 | gpio_switcho OXFFFFAODD | OxFFFFALFF | 0x100 'mb_bbflﬁm_'f_cnt'r
microplaze
opb_gpio 1.00.a ﬂ gpio_ledd OxFFFFBOOD | OxFFFFBIFF | (<100 mii_to_rmii

opbedcr_hndge
ophZplb_bridge
opb_arbiter

Delete >> @ oph_atmc
ophb_bram_if_cntlr

opb_central_dma
opb_core_mspl
opb_core_sspl_ref
ophb_core_sspl_ref
ophb_ddr

apb_emc
oph_ethermet
opb_ethemetlite
opb_gpio

ophb_hdlc

ophb_iic

ophb_intc
ophb_jtag_uart
apb_mdm i

oK | Annulla

Connettiamo i due GPIO all’'opb_bus.
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Add/Edit Hardware Platform Specifications :

Peripherals Bus Cannections lPans ] Parameters]

Click on squares to make master, slave or master-slave (M, 3, MS) connections. Choose one or more (using shiftand Ciel)
Right click on any bus instance (column header) for a context menu. buses and click Add.
)
SIS T T ia
i @‘ 5 dsocm_v10_v1_00_a 5
dsacm_vw10_v1_00_h
blaze dimb M v VR
mblaze dim fsl_v20_v1_00_b =
mhblaze ilmb M isocm_w10_w1_00_a
EGESR " isocm w101 _00_h v
mhlaze ioph M Choose the BRAM porto connect to the controller port.
e 5 Give a name to the connection.
bram_inst_ctrl slmh | S Cntr Port BRAM Fort | Connec...
tag soph 5 bram_data... |bram PORTA j porta
uart saph 5 bram_inst_... |bram PORTB ﬂ porth
gpio_switchl sopb 5
gpio_ledl sopb 5

(0] | Annulla | Applica ‘
Add/Edit Hardware Platform Specifications g

Feripherals I Bus Connections  Forts l Farameters }
Fort Signal Assignments. Filter substring orinstance
Use ctrl and shift for multiple row selections and click Connectto connect ports. ﬂ
Llse Add Portfor external ports that need to be GND or VCC.
The "Range" column for external ports is given as "[LE:UB]" (for e.g.[0:31]) List of Ports. Select one ar mare
ports and Click Add
Instance Port Name Net Name | Polartty | scope |Ra.. |Class  |sensit. |
mblaze CLK ck_27mhz I Internal L| CLK SElEsA &
bram_data_... |LMB_Clk ck_27mhz I Internal j CLK CLK
- INTERRUFT
bram_inst_ctrl |LMBE_Clk clk_27mhz 1 Internal LJ CLK VALID INSTR
jtag aPB_Ck ck_z7mhe I Interral | CLK EE_GETNRITE
Lart CPE_Ck ck_27mhz 1 Internal ﬂ CLK REG_ADDR
Lart R RS232_RX_DATA P 1 Externa > | —— “NAEQ—FF‘{EE% "
Liart T* RS232_TH_DATAP | © Extend = | FIPE_RUNNING
gpio_switchd | OPB_Chk clk_27mhz 1 Internal LJ CLK Add Port TJTREFE‘?_LAEE&TAKEN
gpio_switchQ | GPIO_IO USER_INPUTO_P (o} Externd v |[0:0] FREFETCH_ADDR
IMB_Halted
gpio_ledd OFB_Clk chk_27mhz 1 Internal ﬂ CLK
gpio_ledd GPIC IO USER_LEDO M o] External LJ [n0] bram
data_Imb LMB_Clk ck_27mhz I Internal LJ CLK frar_data, ctrl
data_lmb S¥S_Rst fpga_reset 1 Internal LJ Del LMB_Clk
inst_Imb LB _Clk. clk_27mhz I Internal ﬂ CLK brarr_inst_ctrl
inst_Imb S¥S_Pst foga_reset 1 Internal L| LMB_Clk
opb_bus OPB_Ck ck_27mhz I Internal LJ CLK Connect | Liag
opb_bus S¥YS_Rst fpga_reset 1 Internal LJ ﬁti?rag{k
system MASTER_CLOCK P chk_27mhz ™ External CLK
uart
system EXTEMD_DCM_R... fpga_reset N External RST OFE Clk
system USER_INPUT1 P switchl ledl ™ Externa g;?ml pt
system USER_LECT N switchl_ledl auT Externa T
gpio_switch( 3
0K Annulla Applica
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Connettiamo quindi le porte necessarie dei due GPIO e creiamo un collegamento diretto fra
USER_INPUT1_P e USER_LED1_N.

Impostiamo il parametro C_GPIO_WIDTH a 1 per entrambi i GPIO (infatti necessitiamo di un solo
bit per i dati).

Add/Edit Hardware Platform Specifications

X

Peripherals] Bus Connections] Paorts  Parameters l

Edit Parameters assigned to P Instance in MHS Choose IP Instance for alist of parameters.
These parameter values will override default MPD values 0

Open PDF Doc

Parameters with defaultvalues from MPD.
Parameter Malle Chooge one or mare (using shiftt and ctrl) and click Add.
C_GFIO_WIDTH 1
Parameter Yallie |
C_GPIC_WIDTH 32
C_ALL_INPUTS 4}

[8]4 Annulla Applica
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Il file system.ucf sara in questo caso [2]:

# SYSTEM CLOCKS

NET "MASTER_CLOCK_P" LOC ="AH15";

# DCM RESET EXTENSION

NET "EXTEND_DCM_RESET_P" LOC = "AH7";

# RS232 COMMUNICATION PORT

NET "RS232_TX_DATA_P" LOC ="C9";

NET "RS232_TX_DATA_P" SLOW,;

NET "RS232_TX_DATA_P" IOSTANDARD = LVTTL;
NET "RS232_TX_DATA_P" DRIVE = 12;

NET "RS232_RX_DATA_P"LOC ="C8";

# USER INPUTS AND OUTPUT

NET "USER_INPUTO_P<0>" LOC ="D10"
NET "USER_INPUT1_P" LOC ="F14";

NET "USER_LEDO_N<0>" LOC ="B27";

NET "USER_LEDO_N<0>" SLOW;

NET "USER_LEDO_N<0>"|10STANDARD = LVTTL;
NET "USER_LEDO_N<0>" DRIVE = 12;

NET "USER_LED1_N" LOC ="B22",

NET "USER_LED1_N" SLOW;

NET "USER_LED1_N" IOSTANDARD = LVTTL;
NET "USER_LED1_N"DRIVE = 12;

Generare la Netlist e quindi il Bitstream.
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3.2 IL SOFTWARE

Creiamo ora un programma che legga lo stato dello switch e a seconda della sua posizione
accenda o spenga il led. Inoltre scriva sulla UART una “U” quando é su e “D” quando é giu.

#include "xparameters.h"
#include "xgpio_l.h"
#include "xuartlite_I.h"

main()

{
Xuint8 button[]= "UD";
int OnOff;

XGpio_mSetDataDirection(XPAR_GPIO_SWITCHO_BASEADDR, 1);
XGpio_mSetDataDirection(XPAR_GPIO_LEDO_BASEADDR, 0);
XGpio_mSetDataReg(XPAR_GPIO_LEDO_BASEADDR, 0);

while(1)

OnOff = XGpio_mGetDataReg(XPAR_GPIO_SWITCHO BASEADDR);
XGpio_mSetDataReg(XPAR_GPIO_LEDO BASEADDR, OnOff);
XUartLite_SendByte(XPAR_UART_BASEADDR, button[OnOff]);

}

Abbiamo utilizzato delle librerie di basso livello sia per il GPIO che per la UART.

La funzione Xgpio_mSetDataDirection [10] stabilisce la direzione dei dati per la periferica indicata:
0 corrisponde a input (per lo switch) e 1 corrisponde a output (per il led).

Settiamo poi il valore iniziale del led a spento con la funzione Xgpio_mSetDataReg [11].

I comandi del ciclo infine memorizzano in una variabile di nome OnOff lo stato dello switch e lo
inviano al led e al terminale.
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4. UTILIZZO DELLA ZBT RAM

La MultiMedia Board é dotata di 5 banchi di ZBT RAM da 512 kilobytes ciascuno. In questo
esempio vedremo come creare un sistema in cui far eseguire un programma dalla RAM esterna e
memorizzare dati su di essa. Impareremo anche a importare un core scritto in VHDL o Verilog per
essere utilizzato nel Platform Studio e a eseguire il debugging del software.

Il sistema da creare é molto simile al primo progetto (I'helloworld), ma dobbiamo aggiungere due
cores: un modulo per la distribuzione del clock e il controller per la RAM esterna.
Nell'archivio zbtram.zip é contenuto il progetto completo e funzionante.

4.1 IL CLOCK GENERATOR

Quando abbiamo a che fare con un progetto che non sia estremamente semplice abbiamo bisogno
di un dispositivo che distribuisca il clock all'interno del sistema evitando ritardi e ove necessario
moltiplicando la frequenza del segnale per far si che diversi dispositivi sulla stessa macchina

possano lavorare a frequenze diverse.

La struttura del componente é riportata in figura [12].

Iclk_2?mhz -
DCM
cLKo |
cLkmo|—
BUFG CLKBf—
o CLKFB cLkzrol—
—— cLKIN CLK2X
CLKer_BUF —{DssEN  clkaxisaf—
—{PscLk CLKDV |~
—{FsLi CLKFX
—|PENCDEC CLKFX{80f—
—RsT LOCKED
PSOONE|—
STATUS{T:C |—
| MAIN DCM |
IBUF 2L CLKD
EXTEND_DCM_RESET_P I o BlEe CI:KQU —
5 cLkisof—
DCM_RESET {1 o} CLKFB cLkaTo)—
MEM_CLK_FEIN_P Meors MEMORY FB_IN ] %’ggr‘ CLK?;{Kigﬁ — Hmemow_s‘tmhz =
[MASTER_CLOCK_P 1of —PSCLK CLKDV |— in1_fpga
—Psin CLKFX |— =
MASTER_CLOCK drenecee cuinal _ﬁt\
— LOGKED Iféﬁ reset =
— it PSOONE |— L/
—] sTATUST0 | — fpga_reset
— | vEmoRY Dout_|
— D[H5:0] C{15:0] {memory_i08mRz=>
—] resat_counter_4[15:0] n_resst_counter{15:0]
— enable_reset_counter | BUFGMUX
— —e -
— ooM I o pixel_clock
— . n:LKg—I ' E
i o PIXEL_CLK_MUX
) | \E\UFGl et I _
temninal_sount 10 CLKFB cLkzrol—
U —]cLkin cLkax |-
[pal_mode ALTERNATE_CLOCK | —] Eggﬁz‘ C'-KELXK‘SE -
[ALTERNATE_CLOCK_P —sin cLrxf— BUFG
—dPsINCDEC CLKFXi80|— clk_108mhz
RST LOCKED e =
PSOONE— CLK108_BUF
ER k|l -
3 | BUFG |
. 1" of clk_S4mhz
£ CLKS4_BUF
B
% OBUF_F_12
B

| o [{MEM_CLK_FEoUT P

MEMORY_FE_OUT
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Questo componente non é presente fra i cores di base che possiamo scegliere per creare il nostro
sistema; tuttavia la Xilinx fornisce il sorgente in Verilog [13], ed esso pud essere importato tramite
I'lmport Peripheral Wizard per essere utilizzato nellEDK. Conviene utilizzare la versione
leggermente modificata di questo file che é inclusa nella directory /pcores del progetto finito,
poiché l'originale da degli errori in fase di importazione.

4.2 IMPORT PERIPHERAL WIZARD
Cliccare su Tools -> Import Peripheral Wizard ... e seguire la procedura riportata nelle figure.

Import Peripheral Wizard - Step 1 B|

Core Name and Yersion L

Indicate the name of wour peripheral. Also indicate if wou are using the XPS peripheral
wersion naming scheme.

Enter the name of the top %HOL entity or “erilog module of wour peripheral.

Name ||:I|:u:kgen

[ iJseversionMame: MNotused
bajor Revisian binor Revisian Hardware/Software Compatibility Rewvision

(== R T~ D CH—

Logical library name: clockgen

All the files far this peripheral are compiled inta the logical library named abowe. If the
peripheral refers to other logical libraries, they are assumed to be available in the
current project or in the repositories accessible through the current project settings. Since
all design files are compiled in the same directary, using logical libraries other than
given abowve may cause name space conflicts. Logical libraries named wark are not
allowed.

< Indietro Ansanti > Annulla
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Import Peripheral Wizard - Step 2

o
£ -
-

oy |

Source File Types .
Indicate the types of files that make up wour peripheral. \

Indicate the types of files that make up wour peripheral.

[v HOL Source Files (*wvhd, *4%

[ Metlist Files (* edn, * edf. * ngo, * ngc

[ Documentation Files (*doc, *td, * pdi *)

kare Info

< Indietro Ansanti > | | Annulla

Import Peripheral Wizard - Step 3 g|
SR

HDL Source Files N
Indicate how this tool should locate the HOL files that make up wour peripheral. \

Inwhat HOL is yaour peripheral implemented? Yerilog ﬂ
B

How to locate wour HOL source files
(" Use an=5T projectfile (* pr)
This toal will input the HOL file-set and the logical libraries they are compiled into
from the appropriate lines in the project file.

Path

~

(@ Browse toyvour HDL source files *wvhd, *57%

< Indietro Ansanti > Annulla
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Import Peripheral Wizard - Step 4
HDL Analysis Information

Tt
) a4
Indicate the HOL analyze order and the logical libraries your HOL files are compiled into. \

lze the buttons on the right to add and remowe files, indicate logical libraries and setthe HOL
analyze order,

clockgen  Ddlakvrelazione\cores\clockgens ‘Calect Files...
select Librarny...
More Infa
< Indietro | Seganti » | | Annulla
Import Peripheral Wizard - Step 6 R|
Identify Interrupt Signals Py
[dentify the interrupt signals onwour peripheral. \

Indicate the attributes of the interrupt signals by checking the interrupt port name on the left and then

clicking on the radio buttons to the right. %F5S uses this information to automatically connect the interrupt
pors of wour peripheral.

(MASTER_CLOCE_F ~

AL TERMATE_CLOCK_F

CMEM_CLE_FBOUT_P C C

CIWER_CLE_FBIM_F (" i
[CIE=TEMD_DChd_RESET_F—

Cclk_27mhz

Cclk_Rdmhz ~ = =

[CIclk_108mhz B
v NaInterrupt

Fore Info
< Indietro Ansanti > Annulla
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Import Peripheral Wizard - Step 7 §|
FParameter Attributes Py
Identify the parameters that require special handling. \

melectthe parameter an the left and fill in the attribute walues to the right. These attributes help the
warious tools in #FS integrate this peripheral into the system itis instantiated in.

- List User Parameters only - ﬂ Attributes:
: Farameter Name

Default Yalue

=
bare Info
< Indietro Ansanti > | Annulla
Import Peripheral Wizard - Step 8 §|
Port Attributes Py
Identify the pors that require special handling. \
selectthe port an the left and fill in the attribute walues ta the right. These attributes help the wwarious
tools in #<FS integrate this peripheral inta the systam itis instantiated in.
-List User Ports anly - ﬂ UGS
MASTER, CLOCK B g Etame
ALTERNATE_CLOCK_P QI EEEEED
WER_CLKE_FEQUT P Detault Connection
FMEM_CLE_FEIMN_F YYector Dimension
EXTEND_DCM_RESET_F
clk_27mhz
clk_&4mhz &
clk_108mhz
pixel_clock
memaory_27mhz
el 8
bdore Info
< Indietro Ansanti > Annulla
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Conclusa la procedura € necessario chiudere e riaprire il progetto per poter accedere all'lP
importato.

Se andiamo poi su Add Cores, vediamo che nella lista dei componenti é comparso clock_gen.
Aggiungerlo e cliccare su OK.

Nella finestra a sinistra cliccare sull'istanza del clock_gen da noi creato con il tasto destro del
mouse e quindi su View MPD (Microprocessor Peripheral Description) [14].

Questo é un file che é stato creato automaticamente analizzando il codice HDL per trovare le
connessioni possibili con I'esterno. Purtroppo perd esso dovra essere modificato a mano poiché
alcune delle impostazioni sono errate e darebbero origine a errori.

Nella sezione Peripheral Options sostituiamo OPTION IPTYPE = PERIPHERAL con OPTION
IPTYPE = |IP; possiamo leggere sulla documentazione del formato MPD che [I'opzione
PERIPHERAL va impostata quando il core é connesso con il MicroBlaze tramite bus; il nostro core
non ha invece a che fare con il MicroBlaze ma é connesso a un livello puramente hardware con il
resto del sistema.

Un’altra impostazione che puo risultare spesso utile € OPTION CORE_STATE = DEVELOPMENT.
Aggiungendo quest’opzione il codice HDL per la periferica a cui si riferisce il file MPD verra
ricompilato ogni volta che verra eseguito Generate Netlist; utile quindi per provare dei cambiamenti
“al volo”.

HHR R R R R R R
#Hit

## File : D:\lab\relazione\zbtram\pcores\clockgen\data\clockgen_v2_1_0.mpd

## Desc  : Microprocessor Peripheral Description

it : Automatically generated by PsfUtility
#it

## Created : Fri Mar 05 15:08:03 2004

#H#

HHH R A R R R R A R
BEGIN clockgen

## Peripheral Options

OPTION IPTYPE = IP

OPTION IMP_NETLIST = TRUE
OPTION HDL = VERILOG

## Bus Interfaces
## Generics for VHDL or Parameters for Verilog

## Ports

PORT MASTER_CLOCK_P ="",DIR =1, IOB_STATE = BUF
PORT ALTERNATE_CLOCK_P =", DIR =1, IOB_STATE = BUF
PORT MEM_CLK_FBOUT_P =", DIR =0, IOB_STATE = BUF
PORT MEM_CLK_FBIN_P =" ,DIR =1, IOB_STATE = BUF
PORT EXTEND_DCM_RESET_P ="", DIR =1, I0B_STATE = BUF
PORT clk_27mhz="",DIR =0

PORT clk_54mhz ="", DIR =0

PORT clk_108mhz="", DIR=0

PORT pixel_clock =", DIR =0

PORT memory_27mhz ="", DIR =0

PORT memory_54mhz ="", DIR =0

PORT memory_108mhz ="", DIR =0

PORT pal_mode ="', DIR = |

PORT fpga_reset="", DIR=0

END
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| parametri piu importanti da modificare sono nella sezione Ports. Dobbiamo infatti aggiungere alle
porte MASTER_CLOCK_P, ALTERNATE_CLOCK_P, MEM_CLK_FBOUT_P, MEM_CLK_FBIN_P
e EXTEND_DCM_RESET_P il parametro IOB_STATE = BUF. Esso indica di aggiungere a tutte
queste porte un buffer interno, poiché sono connesse direttamente ad un segnale esterno; senza
questa aggiunta il core darebbe errore in fase di implementazione.

4.3 IL CONTROLLER PER LA ZBT RAM E LA CONFIGURAZIONE DEL SISTEMA

Dobbiamo ora aggiungere il controller per la RAM esterna opb_zbt_controller, quando cerchiamo
di cambiare sezione il programma ci avvertira che questo core é deprecated, il suo utilizzo é
sconsigliato perché non é piu supportato, ma visto che non ce ne sono altri che fanno al caso
nostro e che questo comunque funziona non possiamo fare altro che ignorare I'avvertimento.

Add/Edit Hardware Platform Specifications Bl
Feripherals lBus Cunnectiunsl Parts ] Parameters]

E*EE Cells with white backgrounds can be edited.

E To delete peripherals, choose one ar mare rows and click Delete. Ch.DDSB one ormaore ”.DS (s @il She
shift for multiple selections) fram the
Peripheral |HW ver | Instance | Base Address | High Address | Min listbelow and click Add.
microblaze | 2.00.a ﬂ mbilaze bram_block A
bram_bl... [1.00.a brarm clock_module_ref
— e clockgen
Imb_bra... | 1.00.b bram_data_ctrl | 0x00000000 | Ox0C001FFF  0x800 dem_module
) deor_intc
Imb_bra... |1.00.b bram_inst_ctrl | Cx00000000 | COxQ0001FFF  OxB00 ddr_clock_module._ref
opb_jta.. |100b jtag OxFFFFE000 | OxFFFFS0FF dshbram_if_cntlr
<< Add fit_timer
opb_uar... | 1.00b uart OxFFFFS000 | OxFFFFSOFF 0100 ishram_if_cntlr
clockgen clock_gen Jtagppe_cntlr
Imb_bram_if_cntlr
opb_zbt.. |1.00.a zbt_ctr 0x00300000 | Ox009FFFFF microblaze
rrii_to_rmii

opbZder_bridge
opbZplb_bridge

Celata »» @ Dpl;_atrbiter
oph_atmec

opb_bram_if_cntlr
opb_central_dma
opb_core_mspl
opb_core_ssp0_ref
opb_core_sspl_ref
ophb_ddr

opb_emc
opb_ethermet
opb_aethemetlite
opb_gpio

opb_hdic

opb_iic

opb_intc
opb_jtag_uant bt

OK. | Annulla
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Add/Edit Hardware Platform Specifications

Petipharals Bus Connections WPDHS ] Parameters]

Click on squares to make master, slawve or master-slave (M, 5. M3) connections. Choose one or more {using shiftand Chrl)
Right click on any bus instance (column header) for a context menu. buses and click Add.
)
ST der_v29_A_0_a A
5 @" 7 dsocm_w10_1_00_a =
dsocm_w10_v1_00_b
bl dimb il A
faze o fol_v20_w1_00_b =
mhblaze ilmb il isocm_v10_1_00_=a
il M isocm_»10_1_00_h v
mhlaze ioph M Choose the BRAM portto connect to the confroller port.
T - Give a name to the connection.
bram_inst_ctrl slmb | S Cntlr Port BRAM Port Connector
jtag saph 5 bram_data_ctrl bram_port  RelElpREe/ERES
uart soph 5 bram_inst_ctrl bram_port Rl REelEgg=}
zht_cirl sopb S

0K | Annulla ‘ Applica

Colleghiamo tutte le porte come indicato, la RAM necessita di un gran numero di segnali per
funzionare.
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Add/Edit Hardware Platform Specifications

Peripherals | Bus Connections  Pars 1 Parameters}

Fort Signal Assignments. Filter substring or instance
Use ctrl and shift for multiple row selections and click Connectto connect ports. ﬂ
Use Add Port for external ports that need to be GND or YCC
The "Range" column for external ports is given as "[LE:UB]" ifor e.g.[0:317) List of Ports. Select one or more
ports and Click Add
Instance Port Mame Met Name ‘ pPal... |Scope |Range ‘ Class ‘ Sensit.. ‘
NNNNNNNNNNNNNNNNNNNN =
mblaze QK ck_2¥mhz I Internal L] ClK -
bram_data_ctrl |LMB_Clk ck_27mhz 1 Internal ﬂ CLK CLK
= INTERRUPT
bram_inst_ctrl |LMB_Ck ck_27mhz I Internal ﬂ CLK VALID INETR
jtag CPB_Clk ch_27mhz 1 Inena | CLK FC_Ex
REG_WRITE
uart OFB_Ck clk_27mhz I Internal ﬂ CLK REG_ADDR
t RX RS232_RX_DATA_P 1 | Externa MSP_REG
Har i il xtemd | NEW REG YALUE
uart T RS232_TH_DATA_P o Externd v| PIPE_RUNNING
INTERRLUPT_TAKEM
clock_gen MASTER_CLOCK_P MASTER_CLOCK_P 1 External ﬂ JUMP_ TAKEN
clock_gen ALTERMNATE _CLOCK P ALTERNATE_CLOCK_F 1 External L] PREFETCH_ADDR
clock_gen MEM_CLK_FBOUT P MEM_CLK_FBOUT P o Extend v| Ers R o S,
clock_gen MEM_CLK_FBIN_P MEM_CLE_FBIN_P I External ﬂ E[?ﬂﬂ NNNNNNNNNNNNNNNNN
clock_gen EXTEND_DCM_RESE... | EXTEND_DCM_RESET P I External ﬂ bram_data_ctl
clock_gen fpga_reset fpga_reset o] Internal ﬂ NETE;E'E NNNNNNNNNNNNN
clock_gen ck_27mhz ck_27mhz o] Internal ﬂ brarr_inst_ctrl
clock_gen memary_27mnz MEMGRY_BANKZ_CLK_P o Externd v S | | s
zbt_cirl ZBT_OE N MEMORY_BANKZ2_OEN_M o} External ﬂ e
zbt_ctrl ZBT_CE1M MEMORY_BANK2_CEN_N o Externd ¥ R ﬁgﬁaak
Zht_ctrl FET_CKE_N MEMORY_BANKZ_CLKEN_N a External j ””””””””””””””””””””
uart
zbt_ctrl ZBT_A MEMCRY_BAMNK2_ADDR,_P 0 Extend  v|[0:18] OPE Clk
bt cirl OFB_Clk cle_27mhz 1 Internal ﬂ CLK :Q;EWUPT
zbt_ctrl ZBT_ADYV LD N MEMORY_BANKZ_ADY LD N O External ﬂ ™
Zht_ctrl ZET RW_N MEMORY_BANKZ_WEM_N o Extend v| Del :\;;: Ng;; NNNNNNNNNNNNN
zbt_ctrl ZET_BW_M MEMORY_BANKZ_WEN o} External ﬂ [1:4] MASTE F_CLOCK_FP
o ALTERMATE_CLOCK_P
bt ctrl ZET IO MEMORY_BAMKZ_DATA 0 Externd v |[0:31] Connect | | MEM. GLE FEOUT B
data_lmb LMB_Clk clk_27mhz 1 Internal L] CLK MEM_CLE_FEIN_P
data_lmb SYS_Rst fpga_reset 1 Internal ﬂ E‘EEP;EEDCM*RESETP
inst_mb LMB_Ck ck_27mhz 1 ternal v | CLK c:t.?g;nh;
Cl mnz
inst_Imb SYS_Rst fpga_reset I Internal ﬂ pixel_clock
aph_bis aPB_Ck ck_27mhz 1 Internal ﬂ CLK memary_27mhz
memory_54mhz
opb_bus SYS_Rst fpga_reset 1 Internal ﬂ mernary_108rmhz
pal_mode -

OK Annulla Applica

Ora il reset é gestito dal clock_gen, che ne trasforma il suo stato attivo da alto a basso; quindi se
eravamo partiti dai progetti precedenti rimuovere il parametro C_EXT _RESET HIGH a 0 che
avevamo impostato prima e lasciamo cosi il valore di default che é 1.

Dobbiamo modificare inoltre due parametri dell’opb_zbt _controller. poniamo C_ZBT_ADDR_SIZE
a19e C_EXTERNAL DLIL a1.

Il primo parametro indica il numero di indirizzi della memoria, facendo un rapido calcolo vediamo
che 2 alla diciannovesima potenza corrisponde proprio alla dimensione della memoria che é di 512
KB. Il secondo indica al controller della memoria di non implementare un DLL interno per il
riallineamento del clock in quanto questa funzione é gia svolta dal clock generator.

Per avere informazioni piu precise sui parametri del controller o di una qualsiasi altra periferica
basta consultare i rispettivi data sheets.

Non ci resta che modificare il file system.ucf [2] con le constraints relative al clock generator e al
controller della RAM:
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# SYSTEM CLOCKS
NET "MASTER_CLOCK_P" LOC ="AH15";
NET "ALTERNATE_CLOCK_P" LOC ="AD16";

# MEMORY CLOCK FEEDBACK LOOP

NET "MEM_CLK_FBIN_P" LOC = "AE15",

NET "MEM_CLK_FBOUT_P" LOC = "AH14";

NET "MEM_CLK_FBOUT_P" FAST,;

NET "MEM_CLK_FBOUT_P" IOSTANDARD = LVTTL;
NET "MEM_CLK_FBOUT_P" DRIVE = 12;

# DCM RESET EXTENSION
NET "EXTEND_DCM_RESET_P" LOC = "AHT7";

# RS232 COMMUNICATION PORT

NET "RS232_TX_DATA_P" LOC ="C9",

NET "RS232_TX_DATA_P" SLOW;

NET "RS232_TX_DATA_P" IOSTANDARD = LVTTL;
NET "RS232_TX_DATA_P" DRIVE = 12;

NET "RS232_RX_DATA_P" LOC ="C8";

# define the DCMs

# fout = 27,54,108 MHz FOR INTERNAL LOGIC

INST "clock_gen/clock_gen/MAIN_DCM" DLL_FREQUENCY_MODE = LOW;
INST "clock_gen/clock_gen/MAIN_DCM" CLK_FEEDBACK = 1X;

INST "clock_gen/clock_gen/MAIN_DCM" DUTY_CYCLE_CORRECTION = TRUE;
INST "clock_gen/clock_gen/MAIN_DCM" STARTUP_WAIT = FALSE;

INST "clock_gen/clock_gen/MAIN_DCM" DFS_FREQUENCY_MODE = LOW;
INST "clock_gen/clock_gen/MAIN_DCM" CLKFX_DIVIDE = 1;

INST "clock_gen/clock_gen/MAIN_DCM" CLKFX_MULTIPLY = 4;

INST "clock_gen/clock_gen/MAIN_DCM" CLKOUT_PHASE_SHIFT = NONE;
INST "clock_gen/clock_gen/MAIN_DCM" PHASE_SHIFT = 0;

# fout = 27,54,108 MHz FOR MEMORIES (uses external feedback loop)

INST "clock_gen/clock_gen/MEMORY_DCM" DLL_FREQUENCY_MODE = LOW;
INST "clock_gen/clock_gen/MEMORY_DCM" CLK_FEEDBACK = 1X;

INST "clock_gen/clock_gen/MEMORY_DCM" DUTY_CYCLE_CORRECTION = TRUE;
INST "clock_gen/clock_gen/MEMORY_DCM" STARTUP_WAIT = FALSE;

INST "clock_gen/clock_gen/MEMORY_DCM" DFS_FREQUENCY_MODE = LOW;
INST "clock_gen/clock_gen/MEMORY_DCM" CLKFX_DIVIDE = 1;

INST "clock_gen/clock_gen/MEMORY_DCM" CLKFX_MULTIPLY = 4;

INST "clock_gen/clock_gen/MEMORY_DCM" CLKOUT_PHASE_SHIFT = NONE;
INST "clock_gen/clock_gen/MEMORY_DCM" PHASE_SHIFT = 0;

# fout = 40.00MHz for 60Hz vertical refresh NTSC

# fout = 50.00MHz for 75Hz vertical refresh PAL

INST "clock_gen/clock_gen/PAL_NTSC_DCM" DLL_FREQUENCY_MODE = LOW;
INST "clock_gen/clock_gen/PAL_NTSC_DCM" CLK_FEEDBACK = 1X;

INST "clock_gen/clock_gen/PAL_NTSC_DCM" DUTY_CYCLE_CORRECTION = TRUE;
INST "clock_gen/clock_gen/PAL_NTSC_DCM" STARTUP_WAIT = FALSE;

INST "clock_gen/clock_gen/PAL_NTSC_DCM"DFS_FREQUENCY_MODE = LOW;
INST "clock_gen/clock_gen/PAL_NTSC_DCM" CLKFX_DIVIDE = 5;

INST "clock_gen/clock_gen/PAL_NTSC_DCM" CLKFX_MULTIPLY = 4;

INST "clock_gen/clock_gen/PAL_NTSC_DCM" CLKOUT_PHASE_SHIFT = NONE;
INST "clock_gen/clock_gen/PAL_NTSC_DCM" PHASE_SHIFT = 0;

# PINOUT CONSTRAINTS FOR THE MICROBLAZE and MULTIMEDIA DEMO BOARD
# ZBT RAM MEMORY BANK2

NET "MEMORY_BANK2_CLK_P" LOC = "AJ22";

NET "MEMORY_BANK2_CLK_P" FAST,;

NET "MEMORY_BANK2_CLK_P" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_CLK_P" DRIVE = 12;

NET "MEMORY_BANK2_CLKEN_N"LOC = "AE20";

NET "MEMORY_BANK2_CLKEN_N" FAST;

NET "MEMORY_BANK2_CLKEN_N" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_CLKEN_N" DRIVE = 12;

NET "MEMORY_BANK2_WEN_N"LOC = "AJ23";

NET "MEMORY_BANK2_WEN_N" FAST;

NET "MEMORY_BANK2_WEN_N" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_WEN_N" DRIVE = 12;

NET "MEMORY_BANK2_WEN<1>" LOC = "AF24",

NET "MEMORY_BANK2_WEN<1>" FAST;

NET "MEMORY_BANK2_WEN<1>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_WEN<1>" DRIVE = 12;

30



NET "MEMORY_BANK2_WEN<2>" LOC = "AG23";

NET "MEMORY_BANK2_WEN<2>" FAST;

NET "MEMORY_BANK2_WEN<2>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_WEN<2>" DRIVE = 12;

NET "MEMORY_BANK2_WEN<3>" LOC = "AD20";

NET "MEMORY_BANK2_WEN<3>" FAST;

NET "MEMORY_BANK2_WEN<3>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_WEN<3>" DRIVE = 12;

NET "MEMORY_BANK2_WEN<4>" LOC = "AD21"

NET "MEMORY_BANK2_WEN<4>" FAST;

NET "MEMORY_BANK2_WEN<4>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_WEN<4>" DRIVE = 12;

NET "MEMORY_BANK2_ADV_LD_N"LOC ="AF23";

NET "MEMORY_BANK2_ADV_LD_N" FAST;

NET "MEMORY_BANK2_ADV_LD_N" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_ADV_LD_N"DRIVE = 12;

NET "MEMORY_BANK2_OEN_N" LOC ="AE19",

NET "MEMORY_BANK2_OEN_N" FAST;

NET "MEMORY_BANK2_OEN_N"IOSTANDARD = LVTTL;

NET "MEMORY_BANK2_OEN_N" DRIVE = 12;

NET "MEMORY_BANK2_CEN_N" LOC = "AK25",

NET "MEMORY_BANK2_CEN_N" FAST;

NET "MEMORY_BANK2_CEN_N" IOSTANDARD = LVTTL;

NET "MEMORY_BANK2_CEN_N" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<18>" LOC = "AF22";

NET "MEMORY_BANK2_ADDR_P<18>" FAST;

NET "MEMORY_BANK2_ADDR_P<18>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_ADDR_P<18>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<17>" LOC = "AG21";

NET "MEMORY_BANK2_ADDR_P<17>" FAST,;

NET "MEMORY_BANK2_ADDR_P<17>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_ADDR_P<17>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<16>" LOC = "AE11",

NET "MEMORY_BANK2_ADDR_P<16>" FAST,;

NET "MEMORY_BANK2_ADDR_P<16>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_ADDR_P<16>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<15>" LOC = "AJ7",

NET "MEMORY_BANK2_ADDR_P<15>" FAST;

NET "MEMORY_BANK2_ADDR_P<15>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_ADDR_P<15>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<14>" LOC = "AJ8",

NET "MEMORY_BANK2_ADDR_P<14>" FAST;

NET "MEMORY_BANK2_ADDR_P<14>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_ADDR_P<14>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<13>" LOC = "AGT7",

NET "MEMORY_BANK2_ADDR_P<13>" FAST,;

NET "MEMORY_BANK2_ADDR_P<13>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_ADDR_P<13>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<12>"LOC = "AG8",

NET "MEMORY_BANK2_ADDR_P<12>" FAST,;

NET "MEMORY_BANK2_ADDR_P<12>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_ADDR_P<12>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<11>"LOC ="AD11";

NET "MEMORY_BANK2_ADDR_P<11>" FAST,;

NET "MEMORY_BANK2_ADDR_P<11>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_ADDR_P<11>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<10>"LOC = "AD10"

NET "MEMORY_BANK2_ADDR_P<10>" FAST,;

NET "MEMORY_BANK2_ADDR_P<10>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_ADDR_P<10>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<9>" LOC = "AH23";

NET "MEMORY_BANK2_ADDR_P<9>" FAST;

NET "MEMORY_BANK2_ADDR_P<9>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_ADDR_P<9>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<8>" LOC = "AG22";

NET "MEMORY_BANK2_ADDR_P<8>" FAST,;

NET "MEMORY_BANK2_ADDR_P<8>" IOSTANDARD = LVTTL,
NET "MEMORY_BANK2_ADDR_P<8>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<7>" LOC = "AK24",

NET "MEMORY_BANK2_ADDR_P<7>" FAST;

NET "MEMORY_BANK2_ADDR_P<7>" IOSTANDARD = LVTTL,;
NET "MEMORY_BANK2_ADDR_P<7>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<6>" LOC = "AH24";

NET "MEMORY_BANK2_ADDR_P<6>" FAST;

NET "MEMORY_BANK2_ADDR_P<6>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_ADDR_P<6>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<5>" LOC = "AE9";
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NET "MEMORY_BANK2_ADDR_P<5>" FAST;

NET "MEMORY_BANK2_ADDR_P<5>" IOSTANDARD = LVTTL,;
NET "MEMORY_BANK2_ADDR_P<5>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<4>" LOC = "AE10",

NET "MEMORY_BANK2_ADDR_P<4>" FAST;

NET "MEMORY_BANK2_ADDR_P<4>" [OSTANDARD = LVTTL;
NET "MEMORY_BANK2_ADDR_P<4>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<3>" LOC = "AF7";

NET "MEMORY_BANK2_ADDR_P<3>" FAST,;

NET "MEMORY_BANK2_ADDR_P<3>" IOSTANDARD = LVTTL,;
NET "MEMORY_BANK2_ADDR_P<3>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<2>" LOC = "AF8";

NET "MEMORY_BANK2_ADDR_P<2>" FAST;

NET "MEMORY_BANK2_ADDR_P<2>" IOSTANDARD = LVTTL,;
NET "MEMORY_BANK2_ADDR_P<2>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<1>" LOC = "AK7";

NET "MEMORY_BANK2_ADDR_P<1>" FAST;

NET "MEMORY_BANK2_ADDR_P<1>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_ADDR_P<1>" DRIVE = 12;

NET "MEMORY_BANK2_ADDR_P<0>" LOC = "AJ6";

NET "MEMORY_BANK2_ADDR_P<0>" FAST;

NET "MEMORY_BANK2_ADDR_P<0>" IOSTANDARD = LVTTL,;
NET "MEMORY_BANK2_ADDR_P<0>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<7>"LOC = "AK14";

NET "MEMORY_BANK2_DATA<7>" FAST;

NET "MEMORY_BANK2_DATA<7>" |IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<7>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<6>" LOC = "AG15";

NET "MEMORY_BANK2_DATA<6>" FAST;

NET "MEMORY_BANK2_DATA<6>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<6>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<5>" LOC = "AC14";

NET "MEMORY_BANK2_DATA<5>" FAST;

NET "MEMORY_BANK2_DATA<5>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<5>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<4>" LOC = "AJ14",

NET "MEMORY_BANK2_DATA<4>" FAST;

NET "MEMORY_BANK2_DATA<4>" |OSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<4>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<3>"LOC = "AF11";

NET "MEMORY_BANK2_DATA<3>" FAST;

NET "MEMORY_BANK2_DATA<3>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<3>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<2>" LOC = "AH8";

NET "MEMORY_BANK2_DATA<2>" FAST;

NET "MEMORY_BANK2_DATA<2>" |IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<2>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<1>" LOC = "AK9";

NET "MEMORY_BANK2_DATA<1>" FAST;

NET "MEMORY_BANK2_DATA<1>" |OSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<1>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<0>" LOC = "AG9",

NET "MEMORY_BANK2_DATA<0>" FAST;

NET "MEMORY_BANK2_DATA<0>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<0>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<15>" LOC = "AH22",

NET "MEMORY_BANK2_DATA<15>" FAST,

NET "MEMORY_BANK2_DATA<15>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<15>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<14>" LOC = "AF21";

NET "MEMORY_BANK2_DATA<14>" FAST;

NET "MEMORY_BANK2_DATA<14>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<14>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<13>" LOC = "AK17";

NET "MEMORY_BANK2_DATA<13>" FAST;

NET "MEMORY_BANK2_DATA<13>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<13>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<12>" LOC = "AC16";

NET "MEMORY_BANK2_DATA<12>" FAST,

NET "MEMORY_BANK2_DATA<12>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<12>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<11>" LOC ="AG17";

NET "MEMORY_BANK2_DATA<11>" FAST;

NET "MEMORY_BANK2_DATA<11>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<11>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<10>" LOC = "AJ16";

NET "MEMORY_BANK2_DATA<10>" FAST;



NET "MEMORY_BANK2_DATA<10>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<10>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<9>" LOC = "AH17";

NET "MEMORY_BANK2_DATA<9>" FAST;

NET "MEMORY_BANK2_DATA<9>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<9>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<8>" LOC = "AD15";

NET "MEMORY_BANK2_DATA<8>" FAST;

NET "MEMORY_BANK2_DATA<8>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<8>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<23>" LOC = "AK15";

NET "MEMORY_BANK2_DATA<23>" FAST,

NET "MEMORY_BANK2_DATA<23>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<23>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<22>" LOC = "AH16";

NET "MEMORY_BANK2_DATA<22>" FAST;

NET "MEMORY_BANK2_DATA<22>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<22>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<21>" LOC = "AE16";

NET "MEMORY_BANK2_DATA<21>" FAST;

NET "MEMORY_BANK2_DATA<21>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<21>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<20>" LOC = "AJ17";

NET "MEMORY_BANK2_DATA<20>" FAST,;

NET "MEMORY_BANK2_DATA<20>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<20>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<19>" LOC = "AG16";

NET "MEMORY_BANK2_DATA<19>" FAST,;

NET "MEMORY_BANK2_DATA<19>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<19>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<18>" LOC ="AC17";

NET "MEMORY_BANK2_DATA<18>" FAST;

NET "MEMORY_BANK2_DATA<18>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<18>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<17>" LOC = "AK18";

NET "MEMORY_BANK2_DATA<17>" FAST,

NET "MEMORY_BANK2_DATA<17>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<17>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<16>" LOC = "AF20";

NET "MEMORY_BANK2_DATA<16>" FAST;

NET "MEMORY_BANK2_DATA<16>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<16>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<31>" LOC = "AE12";

NET "MEMORY_BANK2_DATA<31>" FAST;

NET "MEMORY_BANK2_DATA<31>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<31>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<30>" LOC = "AG10";

NET "MEMORY_BANK2_DATA<30>" FAST,;

NET "MEMORY_BANK2_DATA<30>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<30>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<29>" LOC ="AJ9";

NET "MEMORY_BANK2_DATA<29>" FAST;

NET "MEMORY_BANK2_DATA<29>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<29>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<28>" LOC = "AH9";

NET "MEMORY_BANK2_DATA<28>" FAST;

NET "MEMORY_BANK2_DATA<28>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<28>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<27>" LOC = "AF10";

NET "MEMORY_BANK2_DATA<27>" FAST,

NET "MEMORY_BANK2_DATA<27>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<27>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<26>" LOC = "AJ15";

NET "MEMORY_BANK2_DATA<26>" FAST;

NET "MEMORY_BANK2_DATA<26>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<26>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<25>" LOC = "AC15";

NET "MEMORY_BANK2_DATA<25>" FAST;

NET "MEMORY_BANK2_DATA<25>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<25>" DRIVE = 12;

NET "MEMORY_BANK2_DATA<24>" LOC = "AG14";

NET "MEMORY_BANK2_DATA<24>" FAST,

NET "MEMORY_BANK2_DATA<24>" IOSTANDARD = LVTTL;
NET "MEMORY_BANK2_DATA<24>" DRIVE = 12;



4.4 IL SOFTWARE

Utilizziamo il codice helloworld.c ma aggiungiamo un paio di righe che ci permettano di scrivere
direttamente sull’area di memoria desiderata:

#include "stdio.h"
#define MEMADDR ((volatile unsigned long *) 0x00900000)

main()

*MEMADDR=0xABCD1234;
print("Hello World\n\r");
print("l am your new Microblaze\n\r");

}

Prima di compilare il file dobbiamo indicare a che indirizzo andra scaricato I'eseguibile; indichiamo
il base address del controller della RAM, come in figura.

Il valore di default € posto a 0, indirizzo a cui si trova la BRAM, quindi negli esempi precedenti non
avevamo avuto bisogno di cambiare questo parametro.

S/ Settings - instance mblaze B|
Frocessar Froperty ] Emvironment l
Optimization l Directaries Details l Others l

bemory Information
These options are not used for "dcc” compiler.
“ou can specify therm in the linker file for doc.

Frogram Stan Address

Stack Size

Fass Space Separated Options to

Freprocessar (SWp) |

Azzembler ((W'a) |
Linker () |

For example. to pass a symboal definition to the linker,
wou would say -defsym SYMBOL=VALUE

Ik | Annulla

Infine compiliamo, aggiorniamo il bitstream e scarichiamolo sullFPGA.
Vedremo nuovamente I”’Hello World!” sul nostro terminale.
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4.5 IL DEBUGGER

Per vedere che effetto hanno avuto quelle poche righe che abbiamo aggiunto al programma
originale vediamo I'utilizzo del debugger.

Innanzitutto modifichiamo il formato in cui verra compilato il codice sorgente. Esso non sara piu
direttamente eseguibile ma potra essere avviato solo tramite debugger.

Gli indirizzi fino a 0x400 non saranno modificabili perché conterranno il codice di interfacciamento
con il debugger.

S/W Settings - instance mblaze

Optimization ] Directaries l Details Others l
Frocessor Froperty ] Ervironment l

Driver Configuration

Device Driver |'3F'U
Diriveer Wersion |1.IIIIZI.a ﬂ
Interface Lewel |EI ﬂ
Set Defaults ‘
hMode

i Executable

Communication Peripharals
STDIM Peripheral |uart

STODOUT Peripheral |uart

Lef Lef L

Debug Peripheral |jtag

I Annulla
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S/W Settings - instance mblaze g|

Frocessor Froperty l Environment
Optimization l Directaries l Details l Others l

Optimization Farameters

Optimization Level |LEVE| 2 ﬂ

Lewel 3 is the most optimized lewvel.

| Use Global Pointar Optimization

[ Use Hardware Multiplier

Debug Options
(" Do not generate debug symbols

(@ Create symbols for debugging (g option);

(" Create symbols for assembly (-gstabs option)

MOTE: If an optimization levelis get, and -g is also set, the
debug information may not be correlated to source code.

k. Annulla

Creando dei simboli per il debugging potremo seguire in parallelo lo svolgersi delle istruzioni C e il
codice assembler a loro correlato.

E’ preferibile fare Clean Netlist prima di eseguire le prossime operazioni.
Ricompilare il codice, aggiornare il bitstream e scaricare il bitstream sul’FPGA. Ora non apparira

niente sul nostro terminale perché il programma non va direttamente in esecuzione ma attende di
essere caricato nel debugger.

Creiamo nella root del progetto un file xmd.ini [15] che funga da script per far si che il debugger si
connetta automaticamente al MicroBlaze al suo avvio:

# Initialization Tcl script which is sourced by xmd on startup
# display the command help on startup
mbconnect stub -comm jtag -debugdevice devicenr 2

Caricare il debugger con Tools -> XMD
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Grazie allo script esso si collega direttamente al MicroBlaze, tramite interfaccia testuale si pud
accedere alle varie locazioni di memoria e caricare il programma in memoria, ma € molto piu
comodo lavorare con un’interfaccia grafica che gestisca al meglio le sue funzioni.

Cliccare quindi su Tools -> Software Debugger.

Una volta caricato il programma scegliere Run -> Connect to target e settare le impostazioni come
in figura. Il Software Debugger si interfaccia cosi al MicroBlaze tramite il tool XMD.

Target Selection @

v Set breakpoint at 'main’
S |Remote TCP %MD ﬂ ¥ Set breakpoint at ‘exit’
Hostame: |Iocalhost ™ Set breakpoint at |
B |1234 ™ Display Download Dialog
™ LUse xterm as inferior's thy
b More Cptions
Ok Zancel ‘ ‘

Con Run -> Run possiamo eseguire il programma; si pud vedere cosa succede eseguendo una
sola istruzione per volta, un intero ciclo e cosi via.

Il menu View ci permette di indagare sullo stato del MicroBlaze, analizzare il contenuto dei registri,
della memoria....

Clicchiamo View -> Memory e scegliamo di visualizzare i valori relativi all'indirizzo 0x00900000
Facendo scorrere il programma vediamo che a questa locazione viene scritto il valore Oxabcd1234
come da noi indicato nel codice C.

Memory E@@
Addresses
Address [ox200000] =
| Oxabcd1234  Ox2be89409 | Ox11a2140d |OxB65cec2y ...4+....... £\.$
|| 0x600dbd31 |0x11118179 | 0x8cbaf688 | Ox7dOefaec ~..1...y....}...
|| 0x170F84e0 | 0x102075F9 OxOecl11bd3 | OxOe8l4eb24 ... .. Mo pow | $
| 0x30c29e6c | 0x310b0cIT Ox62064e6f | Oxc83c4bSe 0..11...b.No.<K”
| @xTcfd30e5 Ox02278e80 Oxbafear83  Ox0f3di42a |.0..'....... =%
| 0xb0ca7280 |0x0a115016 0x2e6694cl Ox107ad450 ..r...P..f...z.P
110/ 0x0b902f4b | Ox1b8edbbl Oxefl1b2f94  0x45207392 ../K...... /.Es
:1| 0x13189423 | 0x7c225F73 | 0x92a81974 Ox74803ced .. . H|" s...tt.<.
R
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helloworld.c - Source Window E‘B‘

File Run  Mew Control Preferemces Help

FHMOEH0 BT S A8 6 M- E | ex30012¢ 7 =2 2 =
lhelloworld.c > | |main ~| [MIXED |
6 *MEMADDR=0xABCD1234 ; =
= ©0x800110 <main+8>: imm 144
= 0x800114 <main+12>: addik r4, ro, 0 // Ox900000
= 0x800118 <main+16>: imm -21555
H Ox80011¢c <main+20>: addik r3, ro, 4660
i Px800128 <main+32>: SKW r3, ro, ri P

T print(“Hello World!\n\r™);

= Ox800120 <main+24>: imm 128
= 24 i addik r5, ro, 516 800204 <XUartlLite_RecuBytet+2i>
- 2 (nain+36>: orlid  r15, 68 // 0x800170 <print
= Ox800130 <main+40>: or ro, ro, ro
8 print("I am your new Microblaze\n\r");
= 0x800134 <main+44>: imm 128
= Ox800138 <main+48>: addik r5, ro, 532 // 0x800214 <XUartLite_RecuByte+i0>
) Ox80013¢c <maint52>: brlid ri5, 52 // 0x800170 <{print>
= Ox800140 <maint56>: or ro, ro, ro
= Ox800144 <maint60>: 1w ris, ro, ri
= 0x800148 <main+64>: rtsd ris, 8
z 0x80014c <main+68>: addik ri, ri1, 40 _:J

||Program 5 runming.

Abbiamo varie opzioni per visualizzare il codice che viene eseguito passo dopo passo, in questo
caso possiamo vedere per ogni istruzione assembler l'istruzione C associata e i relativi indirizzi di
memoria in cui € memorizzato il codice.

Scrivendo negli opportuni indirizzi di memoria possiamo testare le periferiche (ad esempio
accendere o spegnere un led, che perd qui non é presente) o spedire dati attraverso la UART.
Proviamo per esempio a scrivere 53 all'indirizzo OxFFFF9004 (il byte 4 é destinato alla
trasmissione), sul terminale di Windows apparira una S, corrispondente al carattere ASCIl 0x53.

Addresses

Address [0xFFFF2004 2

| 9x0000053 0x00000000 OxOOOE0000 OxO0000000 ... .............
©x00000000 0x00000004 0xDOO00O00 Ox0O060008 .. ..............
' 0x00000000 0x00000004 0x00000000 O0x00600000 | ................
| 6x00000000  Ox00000004 Ox00000000 Ox6O6OO000 ... .............
' 9x00000000 Ox0000000Y OxOEO00000 OxOOEE0000 .. ..............
0x00000000 0x00000004 0x00000000 Ox00000000 .. ..............
' 0x00000000 0x00000004 0xO0000000 0x00600000  ................
0x00000000 0x00000004 0xOO0000OO0 OxOOOOOO68 .. ... ...........
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5. ELABORAZIONE VIDEO IN TEMPO REALE

L’ultimo progetto, molto piu complesso e articolato dei precedenti, consiste nella realizzazione di
un’infrastruttura per editing video in tempo reale su MultiMedia Board; gli effetti che verranno
applicati al video sono limitati ma pud essere un buon punto di partenza per elaborazioni piu
complesse. Il progetto completo é contenuto all’interno del file videoelab.zip.

A differenza dei progetti precedenti, vedremo solo la struttura e il funzionamento del sistema in
quanto oramai l'utilizzo dellEDK dovrebbe essere stato acquisito; inoltre una spiegazione passo
dopo passo sarebbe in questo caso troppo lunga e noiosa, data la complessita del sistema.

5.1 Introduzione

Il sistema finito verra realizzato connettendo all'ingresso video composito della MultiMedia Board
un dispositivo che generi un segnale secondo lo standard PAL (ad esempio una telecamera); tale
segnale analogico verra convertito in digitale dal decoder integrato sulla board.

L’output di tale dispositivo € costituito da un flusso di 10 bit in cui sono multiplexati i dati video utili
e i codici di controllo per la sincronizzazione che indicano la fine di ogni frame: i vari canali del
segnale dovranno essere quindi separati opportunamente; separate le componenti potremo
elaborarle individualmente tramite una periferica hardware, le cui impostazioni saranno fornite dal
MicroBlaze, interfacciato agli otto tasti di colore giallo presenti sulla board.

A questo punto le componenti, eventualmente modificate, saranno nuovamente multiplexate e
verranno reinserite nel flusso di bit le informazioni per la sincronizzazione.

Il segnale complessivo verra inviato quindi allencoder video che lo convertira da digitale in
analogico inviandolo all’'uscita video composito a cui avremo connesso un televisore.

Il decoder e I'encoder dovranno essere configurati secondo il protocollo I°C (Inter-Integrated
Circuit) in maniera opportuna da poter trattare un segnale video di tipo PAL.

Analizzeremo separatamente le 5 parti in cui pud essere scomposto il sistema:

il nucleo, composto dal MicroBlaze e le periferiche piu generiche;
I'utilizzo e la configurazione dei tasti;

la programmazione dei dispositivi secondo I'I°’C;

il trattamento dei segnali video;

l'interfacciamento con il software.

5.2 IL NUCLEO DEL SISTEMA

Il nucleo del sistema é molto simile a quello del progetto precedente; esso é composto da:

e un MicroBlaze che comunica con le memorie e le periferiche tramite due local memory bus
e un OPB bus;

e 32 kilobytes di RAM interna al’FPGA;

e 512 kilobytes di ZBT RAM esterna, essa non viene utilizzata ma é stata integrata qualora,
volendo considerare questo progetto come punto di partenza per un sistema piu
complesso, si necessiti di maggiore memoria per il programma o i dati;

e un distributore e allineatore di clock, piu semplice di quello utilizzato precedentemente ma
con alcune funzioni aggiuntive;

¢ una JTAG per la programmazione e il debugging;

e una UART RS232 per visualizzare su terminale le impostazioni del sistema.

Alcune periferiche e l'impostazione generale del sistema sono state prese dall’esempio
MicroBlaze _Media_Brd_IIC_vidtest edk3_2_sp1 presente sul sito della Xilinx all’indirizzo
http://www.xilinx.com/products/support/multimedia/examples/; tuttavia, essendo stato concepito
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per la versione 3.2 del’lEDK, esso ha necessitato di un po’ di modifiche per poter funzionare
correttamente sulla versione 6.1i.

Il core MicroBlaze Brd ZBT ClkGen, preso dall' esempio citato, é costituito da due soli DCM (uno
per il sistema in generale e uno per la memoria) e non da tre come quello fornito dalla Xilinx (il
clockgen.v che abbiamo visto in precedenza). Esso inoltre integra alcune utili funzioni aggiuntive,
come il segnale di Startup alla CPLD, che vedremo in maggior dettaglio nel prossimo paragrafo.

Il sistema presenta un difetto a causa del fatto che il MicroBlaze Brd ZBT_ClkGen contiene un
errore di programmazione: la porta a cui dovrebbe essere inviato il segnale di clock riallineato,
pronto per essere inviato alla RAM esterna, non é collegata in realta a nessun segnale interno. A
causa di cid non é possibile far girare correttamente il programma dalla ZBT RAM, anche se in
teoria il sistema sarebbe predisposto per farlo. Per ovviare a questo problema sarebbe necessario
studiare a fondo il codice VHDL del componente e correggerlo, magari confrontandolo con il core
clockgen.v (che perd é in verilog) [13] per individuare I'errore e collegare la porta al segnale
opportuno.

5.3 1 PUSHBUTTONS E LA CPLD

Sulla MultiMedia Board ¢é integrata anche una CPLD [16]. Come si pu0 vedere nei suoi schematici
[17], sotto riportati, essa provvede a un gran numero di compiti diversi, quali la distribuzione dei
clock, del reset e la gestione dei 10 pushbuttons e i led a loro associati.

| tasti vengono gestiti dalla CPLD anziché dallFPGA perché altrimenti stato necessario utilizzare
10 pin per interfacciarli tutti; con questo sistema essi possono essere configurati a piacere,
premendo il tasto ENTER la loro configurazione viene rilevata dalla CPLD che trasmette a sua
volta il loro stato in maniera seriale al’lFPGA utilizzando quindi un solo pin (in realta sono tre
perché si utilizza anche uno per il clock e uno per il reset).

KC95144XL_TQ100
RESET_N i FESET_IN

VIDED_CECOOER_RESET_2 P ———— %)  VIDED, DECODER_RESET_Z

clockzmiz Y=ol nekznaz
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EMET_RESET 7 Pl ENET_RESET.Z

= TV_OUT_RESET 2 pli 3  TV_OUTRESETZ Ui
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L'utilizzo dei tasti pud essere impostato in due modi differenti, a seconda di come viene
programmata la CPLD. La Xilinx fornisce due configurazioni di base da trasferire tramite JTAG
sulla CPLD: i files normal.jed e video.jed [18]. Noi utilizzeremo il primo, in quanto esso permette di
impostare una combinazione qualsiasi dei 10 tasti e poi selezionarla tramite il tasto ENTER. Se
avessimo deciso di optare per l'altra configurazione sarebbe stato possibile utilizzare solo due tasti
contemporaneamente, cioé uno dei due gialli (che sul manuale suggeriscono di utilizzare per la
scelta della sorgente video) e uno degli otto blu (che dovrebbero essere dedicati alla scelta
dell’elaborazione da applicare al video).

Bisogna quindi ricordarsi di programmare la CPLD prima di programmare I'FPGA altrimenti
potrebbe darsi che essa non si trovi nella modalita corretta.

A seconda della configurazione della CPLD bisogna importare un core differente fornito dalla
Xilinx: il file PB_SCAN_DATA_IN.v (relativo al normal.jed) oppure VIDEO_PB_SCAN_DATA_IN.v
(relativo al video.jed); bisogna apportare della lievi modifiche a questi file altrimenti danno degli
errori in compilazione, pertanto suggerisco di usare il file incluso in questo progetto, che ¢é gia stato
corretto; tuttavia se si preferisce partire con i file originali si riesce ad individuare velocemente il
problema con I'Answer Database del sito della Xilinx.

Vedremo successivamente come il pb_scan _data _in é connesso con il resto del sistema per la
sua configurazione.

Per il suo corretto funzionamento la CPLD necessita di ricevere un segnale di STARTUP dal resto
del sistema. Nel nostro caso questo segnale viene fornito allavvio del sistema dal
MicroBlaze_Brd _ZBT_ClkGen all’avvio.

5.4 LA CONFIGURAZIONE DELL’ENCODER E DEL DECODER

| convertitori A/D e D/A integrati sulla MultiMedia Board [19] possono essere configurati in maniera
molto ampia in quanto sono predisposti per supportare un gran numero di standard diversi e
permettono di intervenire su molti parametri per elaborare direttamente il segnale oltre a
convertirlo. Per i nostri scopi sara sufficiente configurare i registri dei dispositivi in modo da
convertire un segnale video composito di tipo PAL in un segnale digitale in formato YCrCb 4:2:2 e
viceversa; la Xilinx fornisce dei valori consigliati da memorizzare nei registri [20], che devono
essere programmati secondo lo standard I°C. Riportiamo qui una breve spiegazione del protocollo
I°’C; qualora fossero necessarie informazioni piu dettagliate ci si riferisca alla pagina web
http://www.semiconductors.philips.com/buses/i2c/.

Il bus I°C é composto da due fili, serial data (SDA) e serial clock (SCL), che trasportano
informazioni fra i dispositivi connessi al bus. Le linee, entrambe bidirezionali, sono connesse a un
generatore di tensione positiva tramite una resistenza di pull-up. In questa maniera quando il bus é
libero entrambe le linee sono alte.

Ogni dispositivo connesso al bus ha un unico indirizzo e pud operare sia come trasmittente o
ricevente; inoltre ognuno puo essere configurato come Master o Slave.

Il Master ¢ il dispositivo che inizia il trasferimento di dati sul bus e genera i segnali di clock per
permettere questo trasferimento. Tutti gli altri dispositivi collegati sono considerati Slave.

La trasmissione di dati sul bus I°C ha inizio quando si é in condizione di START e ha termine
quando si é in condizione di STOP.

Lo stato alto o basso della linea SDA pud cambiare solo quando SCL é basso.

La condizione di START é un caso unico definito come una transizione da alto a basso su SDA
mentre SCL ¢é alto.

Allo stesso modo la condizione di STOP si ha solo nel caso in cui SDA passi da basso ad alto
mentre SCL ¢é alto.

Queste condizioni esclusive assicurano che START e STOP non possano mai essere confusi con i
dati validi.

41



Ogni pacchetto di dati consiste di otto bit seguiti da un bit di acknowledge, in modo che la
trasmissione completa consista di nove giri di clock. | dati sono trasmessi cominciando dal bit piu
significativo (MSB).

Il dispositivo che trasmette rilascia la SDA durante il bit di acknowledge e il ricevente deve
abbassare SDA per indicare I'avvenuta ricezione dei dati.

- =

SDA ;™77 X
TN\ XX XN\ va
1 | e 1 1
1 | 1 1
SCL 1 1 1 1
s L z & t g s PP
e el e —  d e e e - oo e o
START ACK STOP
CONDITION CONDITION

La comunicazione sul bus fra il Master e uno Slave é composta da quattro parti: START, indirizzo
dello Slave, trasmissione dati, STOP.

Il protocollo I°C definisce un formato per la trasmissione dei dati sia per indirizzi di 7 che di 10 bit.
Un indirizzo di 7 bit é inizializzato nella seguente maniera: dopo una condizione di START, viene
inviato l'indirizzo dello Slave. Questo indirizzo € composto da 7 bit seguiti da un ottavo bit che
indica se il dispositivo deve essere inizializzato in lettura (“1”) o in scrittura (“0”). Solo lo Slave con
l'indirizzo corrispondente a quello trasmesso dal Master risponde trasmettendo a sua volta un
acknowledge (abbassando la linea SDA al nono giro di clock).

Una volta che viene realizzato con successo I'indirizzamento dello Slave il trasferimento di dati puo
procedere byte per byte.

SEQUENCE s | sLave aDDR |A(s)| suBaDDR |[A(s) DATA IR oA as)| P
F
LsB=0 1oL
i '
READ o —
SEQUENCE s | sLave ADDR [AS)| susaDDR |A(s)| s | sLave aopr |ags) DATA  |Am pata  |Emy| P
S=STARTBIT A(S)= ACKNOWLEDGE BY SLAVE (S = NO-ACKNOWLEDGE BY SLAVE

A
P =STOP BIT A(M) = ACKNOWLEDGE BY MASTER A(M) = NO-ACKNOWLEDGE BY MASTER

Per quanto riguarda I'implementazione della programmazione del’l’C mi sono basato sul
sopracitato esempio tratto dal sito Xilinx. | registri vengono programmati in maniera quasi
totalmente software. Il MicroBlaze viene interfacciato ai dispositivi tramite una sorta di GPIO
personalizzato programmato dall’autore, tale che permette di trattare piu segnali indipendenti (a
differenza di quello originale che lavora solo con vettori); esso é connesso a un’interfaccia molto
semplice che si collega direttamente ai due segnali SCL e SDA del bus I°C.

| rispettivi cores sono gpio_mod.vhd e gpioZiic.vhd.

Tutta la gestione pratica dei segnali di START, STOP, trasmissione dell’indirizzo e trasmissione
dati é realizzata via software, la parte hardware si limita a fare passare i segnali generati dal
codice C e inviarli in output ai pin specificati.

Si presti attenzione al fatto che gli switch S VIDEO/COMP VIDEO e NTSC/PAL presenti sulla

board sono connessi direttamente al decoder e all’encoder. Per un corretto utilizzo nel nostro
sistema dovremo settarli a comp video e pal rispettivamente.
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5.5 LELABORAZIONE VIDEO

L’elaborazione del segnale video all’interno del sistema viene svolta dai seguenti componenti:

vid_resync_buf. uniforma il clock del flusso di dati video alla frequenza del resto del
sistema;

video_block: separa i dati video utili dalle informazioni di controllo relative alla
sincronizzazione e poi le ricompone in un unico flusso di dati dopo un’eventuale
elaborazione;

YCrCb_demultiplexer. separa le tre componenti (una luminanza e due crominanze) dei dati
video utili;

multiplexer_elab: ricompone in un unico flusso di bit le tre componenti delimmagine
aggiungendo ad ognuna un eventuale valore configurato tramite i tasti, interfacciati con il
MicroBlaze.

Ho riportato qui sotto uno schema indicativo della parte di sistema che si occupa dell’elaborazione
video. Gli ingressi del clock e del reset non sono stati collegati per non appesantire la figura
(eccetto il reset di multiplexer_elab, poiché é interfacciato direttamente con il video_block e non
con il reset del resto del sistema).

[opio ¥ .
(mo o multiplexer_elab
[ mpio_Ch’» reset YErGh_out

s—— clock

¥_modif

Cr_modif

Ch_modif

ycrch_demultiplexer

vid_resync_buf

o——clock

o——reset

YCrch_in

Y_out

Cr_out

Y_in

Ch_out

Cr_in

video_block

[—

[—

decader_output —
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5.5.1 vid_resync_buf

BEGIN vid_resync_buf

PARAMETER INSTANCE = vid_resync_buf in
PARAMETER HW_VER = 1.00.a

PORT reset = fpga_reset

PORT YCrCb_reg out =YCrCb_in

PORT vid_27mhz_input_clock = line_locked_clock
PORT vid_27mhz_output_clock = clk_27mhz
PORT YCrCb_input = YCRCB

END

YCrCb_reg_input: dati in ingresso nel buffer provenienti dal decoder PAL
Y _CrCb_reg_out: dati in uscita dal buffer

vid_27mhz_input_clock: clock dei dati in ingresso
vid_27mhz_output_clock: clock dei dati in uscita

Il decoder PAL fa uscire i 10 bit del segnale video con una frequenza che é diversa da quella del
resto del sistema.

Il vid_resync_buf, pertanto, prende in ingresso i 10 bit che giungono con la frequenza a cui |l
decoder li trasmette e li memorizza in un buffer; i dati vengono poi letti dal buffer a una velocita che
€ allineata a quella del resto del sistema.

Le frequenze dei due segnali di clock a cui i bit vengono prima ricevuti e poi inviati sono
leggermente diverse, entrambe a circa 27 mHz; per questo motivo noteremo sullo schermo una
perdita di sincronia momentanea con una frequenza di circa 1 Hz. Questo avviene quando
vengono scritti nel buffer i dati relativi a una zona di schermo che non é ancora stata letta.

5.5.2 video_block

BEGIN video_block

PARAMETER INSTANCE = video_block_inst
PORT clock = clk_27mhz

PORT reset = fpga_reset

PORT synch_data_in = synch_data
PORT synch_data_out = synch_data
PORT pixel_data_out = pixel_data_out
PORT pixel_data_in = pixel_data_in
PORT YCrCb_in = YCrCb_in

PORT YCrCb_out = YCRCB_P

PORT reset_out = reset_out

END

YCrCb_in: dati provenienti dal vid_resync_buf

synch_data_out/pixel_data_out:. uscite separate per codici di controllo e dati video ottenute dal
demultiplexing del segnale proveniente da YCrCb_in

synch_data_in/pixel_data_in: ingressi separati per codici di controllo e dati video

YCrCb_out: porta da cui escono multiplexati i dati provenienti da synch_data_in e pixel_data_in, diretti
all’encoder PAL

reset_out: porta collegata a YCrCb_demultiplexer, per indicare quando si tratta di dati video (segnale
basso) o codici di controllo (segnale alto)
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I componente video block accetta in ingresso il flusso di dati a 10 bit proveniente dal
vid_resync_buf e ne separa le parti relative alla sincronizzazione (cioé i codici di controllo che
indicano la fine di un frame) e i dati video utili.

Nella figura sottostante é indicato il formato dei codici di controllo:

Y /

ANALOG
VIDEO

EAV CODE SAV CODE
c[, [rToTolx[el1]8T o[F[Falala ANBDAEANRENENENENE
INPUT PIXELS YIr|Y|Flo|o|¥|olo|lo|o]***|o|F|F|B|e|e|***| ofelolo]r|a|o]¥]||Y|r|Y]|b]Y|r|Y]o]***
ANCIIEhiEE)DATA
4 CLOCK 4CLOCK
NTSC/PAL M SYSTEM
— e ——————— —_—
{525 LINES/60Hz) 268 CLOCK 1440 GLOCK
4 CLOCK 4 CLOCK
PAL SYSTEM
—_——— —————————— —_—
(625 LINES/50Hz) 280 CLOCK 1440 CLOCK
END OF ACTIVE START OF ACTIVE
VIDEO LINE VIDEO LINE

Al loro interno possono essere indicate varie configurazioni relative alle impostazioni desiderate,
ma andare a fondo in cid esula dallo scopo del progetto.

Come vediamo in figura, nello standard PAL a 50 Hz i codici di controllo durano per 4 + 280 + 4 =
288 giri di clock.

Questi codici sono del tipo indicato e inizieranno sempre e comunque con una situazione in cui
tutti i 10 bit sono a 1 (in figura é indicato “FF” perché é relativa a un formato a 8 bit).

Le configurazioni in cui tutti i bit sono a “0” o tutti i bit sono a “1” sono riservate, non indicano dati
validi ma sicuramente sono informazioni di controllo.

Tutto cio che fa il video_elab é rilevare I'arrivo di 10 bit tutti a 1 dalla porta YCrCb_in: in questo
caso invia tali bit e i successivi 287 gruppi di 10 bit all’uscita synch_data_out e alluscita diretta
all’encoder PAL (YCrCb_out) associa il segnale proveniente dal synch_data_in.

Per tutto il resto del tempo invia i bit provenienti da YCrCb _in all’'uscita pixel _data_out e associa a
YCrCb_out il segnale proveniente dall'ingresso pixel_data_in.

In questo modo possiamo intervenire solamente sul flusso di dati video utili (che escono quindi da
pixel_data_out e rientrano da pixel_data_in) senza modificare i codici di controllo; ovviamente
applicando anche ad essi le elaborazioni verrebbero perse le informazioni relative alla sincronia.
L’'uscita dei codici di controllo synch_data out é stata collegata direttamente al rispettivo ingresso
synch_data_in poiché non ci interessa intervenire su tali segnali, ma tuttavia € chiaramente
possibile operare anche su di essi, qualora se ne presentasse la necessita.

Fra pixel_data_out e pixel_data_in sono invece inseriti gli altri componenti dedicati all’elaborazione
vera e propria del segnale video, che vedremo piu in dettaglio nelle sezioni successive. In questa
posizione bisogna stare attenti a non inserire logica troppo complessa, altrimenti é possibile che i
dati video utili elaborati arrivino in ritardo rispetto ai codici di controllo, causando una perdita di
sincronia. Ad esempio, se i dati video arrivassero con il ritardo di un periodo clock, avremmo che
luminanza e crominanze verrebbero scambiate.
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5.5.3 YCrCb_demultiplexer

BEGIN YCrCb_demultiplexer

PARAMETER INSTANCE = demultiplexer_inst
PORT clock = clk_27mhz

PORT reset = reset_out

PORT Y_out=Y_dem_out

PORT Cr_out = Cr_dem_out

PORT Cb_out = Cb_dem_out

PORT YCrCb_in = pixel_data_out

END

reset: il componente viene mantenuto in stato di reset dal video_block finché non comincia la
trasmissione di dati video

YCrCb_in: dati video in ingresso

Y out, Cr_out, Cb_out: canali dei dati video in uscita

Il YCrCb_demultiplexer elabora il flusso di dati video utili ottenuto dal video_block e invia su 3
canali distinti la luminanza e le due crominanze. | dati video sono codificati in formato YCrCb 4:2:2
a 10 bit.

Secondo questo standard ogni pixel ha un valore per la luminanza e due valori per le crominanze,
questi ultimi perd sono in comune con il pixel adiacente. In questo caso i canali multiplexati, cosi
come provengono dal decoder, sono del tipo:

Cb dei pixel 1 e 2
Y del pixel 1
Cr dei pixel 1 e 2
Y del pixel 2
Cb dei pixel 3 e 4
Y del pixel 3
Crdeipixel3e 4
Y del pixel 4
€ cosi via...

Il YCrCb_demultiplexer viene mantenuto in stato di reset dal video_block finché non comincia la
trasmissione di dati video utili; senza questo accorgimento succede spesso che i tre segnali Y, Cr
e Cb demultiplexati non vengano posti sulla propria uscita ma su quella di uno degli altri canali.
Mantenendo il componente in stato di reset finché non vengono ricevuti dati fa si che al primo
turno abbiamo sempre la Cb, al secondo la Y, al terzo la Cr, al quarto nuovamente la Y, e via
discorrendo.
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5.5.4 multiplexer_elab

BEGIN multiplexer_elab
PARAMETER INSTANCE = multiplexer_elab_inst
PORT clock = clk_27mhz

PORT reset = fpga_reset

PORT Y_in=Y_dem_out

PORT Cr_in = Cr_dem_out
PORT Cb_in = Cb_dem_out
PORT Y_modif = Y_modif

PORT Cr_modif = Cr_modif
PORT Cb_modif = Cb_maodif
PORT YCrCb_out = pixel_data_in
END

Y _in, Cr_in, Cb_in: dati provenienti dal multiplexer
Y_modif, Cr_modif, Cb_modif. quantita che si vuole aggiungere a ogni componente
YCrCb_out: uscita dati video elaborati e multiplexati da inviare all'ingresso del video_block

Il multiplexer_elab multiplexa i canali provenienti dal YCrCbh_demultiplexer aggiungendo a ogni
componente una costante indicata tramite il MicroBlaze e i tasti della board. Le tre costanti da
aggiungere ai tre canali sono indipendenti.

Qualora il valore ottenuto dalla somma di un valore con la costante addizionale superi il valore
1023 (massimo numero rappresentabile con 10 bit) il bit piu significativo viene trascurato (in pratica
si somma il valore in esubero ripartendo da 0).
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5.6 LINTERFACCIA SOFTWARE

5.6.1 Le periferiche di input/output

Come gia visto i 10 tasti presenti sulla MultiMedia Board sono interfacciati con il resto del sistema
tramite il pb_scan_data_in; i segnali corrispondenti agli otto bottoni blu (da pb3 a pb10) vengono
quindi collegati a scal2vect8bit. Questo semplice componente converte gli 8 segnali indipendenti in
un unico vettore a 8 componenti, in modo da poter essere interfacciato con un GPIO
(gpio_button_in) tramite cui leggere dal MicroBlaze lo stato degli 8 tasti.

Si é deciso di lasciare scollegati i primi 2 tasti qualora potessero servire per interfacciarsi a qualche
altra periferica indipendente dal MicroBlaze.

La configurazione dei tasti viene letta dal MicroBlaze e in base al programma caricato verrrano
inviati al multiplexer_elab il valori opportuni da aggiungere alle componenti Y, Cr e Cb dei dati. |
rispettivi dati saranno inviati dal MicroBlaze alla periferica tramite tre diversi GPIO (gpio_Y,
gpio_Cr, gpio_Cb).

Bisogna fare attenzione ad utilizzare la versione del GPIO piu consona ad ogni situazione. Sono
state riscontrate parecchie difficoltd nel collegare segnali interni al sistema tramite GPIO. Infatti
sembra che la porta GPIO_|O possa essere utilizzata solo per collegare pin esterni dellFPGA, ed
€ peraltro I'unica porta disponibile sulla versione 1.00 del GPIO. Si é dovuto ricorrere a porte
unidirezionali (presenti nella versione 3.00) quali le GPIO_in e GPIO_d_out, a seconda che il GPIO
sia utilizzato in lettura o in scrittura dal MicroBlaze.

5.6.2 ll codice C

gpio.c e gpio.h

Il codice dei files gpio.c e gpio.h si occupa della configurazione dell’encoder e del decoder
secondo il protocollo I2C. Sono stati presi entrambi dal’esempio presente sul sito della Xilinx e
sono piuttosto complessi percid non ci soffermeremo su di essi.

Le uniche parti che sono state modificate rispetto all’'originale sono alcuni valori che vanno
scritti nei registri dell’encoder e del decoder. Le impostazioni di entrambi i dispositivi sono ora
settate per funzionare con ingresso e uscita di tipo PAL video composito. Modificando i valori
dei registri i dispositivi possono essere configurati in maniera molto ampia, ma si presti
attenzione che se si volesse lavorare con video NTSC sarebbe necessario cambiare anche altri
parametri del sistema, modificando ad esempio il numero di cicli di clock relativi ai codici di
controllo nel componente video_ block.

videoelab.c

Caricando nella memoria del sistema I'eseguibile creato da videoelab.c I'hardware viene
configurato nel seguente modo:

o con la funzione program video() descritta nei files gpio.h e gpio.c vengono configurati i
registri del decoder e dell’encoder.

o tramite i tasti blu viene impostato il valore da aggiungere a ogni canale, in particolare: nello
stato iniziale a tutti le componenti viene aggiunto un valore nullo; ad ogni passo successivo, in
base alla configurazione dei pulsanti al momento della pressione del tasto ENTER viene
modificata ogni singola componente nella seguente maniera:
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pb3: il valore da aggiungere alla luminosita Y viene diminuito di 10;

pb4: il valore da aggiungere alla luminosita Y viene incrementato di 10;
pb5: il valore da aggiungere alla crominanza Cr viene diminuito di 10;
pb6: il valore da aggiungere alla crominanza Cr viene incrementato di 10;
pb7: il valore da aggiungere alla crominanza Cb viene diminuito di 10;
pb8: il valore da aggiungere alla crominanza Cb viene incrementato di 10;

e i valori devono essere compresi fra 0 e 1023, le modifiche non possono superare questi limiti;

e possono essere premuti anche piu tasti allo stesso tempo, il loro effetto verra applicato
contemporaneamente (cio significa ad esempio che se premiamo contemporaneamente pb3 e
pb4, non verra apportata alcuna modifica alla luminosita);

e il programma rileva solo il cambiamento di stato dei pulsanti: ci0d significa che fra due pressioni
consecutive del tasto ENTER la configurazione dei pulsanti deve essere diversa altrimenti la
seconda non sortira alcun effetto.

o | valori che vengono aggiunti volta per volta possono essere visualizzati tramite un
terminale eventualmente connesso alla porta RS232, ad esempio, con I'HyperTerminal di
Windows.

o | valori settati tramite il programma vengono inviati ai tre GPIO destinati a configurare il
multiplexer_elab con i tre valori da aggiungere in ogni momento.

Per la comunicazione del software con i GPIO sono state utilizzate delle funzioni prese dalle
librerie Xilinx di livello piu alto, includendo il file xgpio.h.

Segue una breve descrizione delle funzioni utilizzate [21]:

Xstatus XGpio_Initialize(XGpio * InstancePtr, Xuint16 Deviceld) inizializza I'istanza di tipo XGpio indicate
dal Deviceld.

InstancePtr é un puntatore ad un’istanza di tipo XGpio. La memoria a cui si riferisce il puntatore
dev’essere preallocata dal programma che richiama la funzione.

Deviceld é un identificatore che definisce univocamente il dispositivo controllato dal componente di tipo
XGpio. Le specifiche con i vari identificatori e i relativi indirizzi de memoria per ogni componente sono
indicate dal file xparameters.h.

void XGpio SetDataDirection(XGpio * InstancePtr, Xuint32 DirectionMask) é utilizzato per settare la
direzione dei dati in transito sul GPIO.

DirectionMask € una maschera che specifica per ogni bit se esso é utilizzato in scrittura (“1”) o in lettura
(HOH).

Le funzioni void XGpio DiscreteWrite(XGpio * InstancePtr, Xuint32 Data)
e Xuint32 XGpio DiscreteRead(XGpio * InstancePtr) sono utilizzate per accedere rispettivamente in
scrittura e in lettura ai registri del GPIO.

Poiché lo stato dei pulsanti viene visto dal MicroBlaze solo come un numero, il programma deve
estrarre da tale valore lo stato di ogni singolo tasto e memorizzarlo in una variabile. In questa
maniera é possibile per il software rilevare in ogni momento quali tasti sono settati e quali no e
configurare cosi il sistema secondo la procedura vista sopra.

demo.c

Il codice del programma demo.c € molto simile a quello di videoelab.c; 'unica differenza é nella
maniera in cui viene configurato il sistema.

Se pb3 é attivo ad ogni ciclo del programma verra incrementato di 8 il valore da aggiungere alla
luminosita; nello stato iniziale esso é 0, quando arriva a 1024 si ricomincia da 0.

Se pb4 é attivo viene incrementato in maniera analoga il valore da aggiungere alla crominanza Cr.
Se pb5 ¢ attivo viene incrementato in maniera analoga il valore da aggiungere alla crominanza Cb.
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5.7 Boot da CompactFlash

Una caratteristica molto interessante offerta dalla MultiMedia Board é la possibilita di caricare la
configurazione del sistema direttamente da CompactFlash [21]. E’ possibile memorizzare fino a 8
file diversi; la scelta della configurazione da caricare su FPGA viene fatta tramite i tre switch CF
CONFIG NUMBER presenti sulla board.

Il tool iIMPACT, disponibile fra gli Accessories dell’ISE, permette di preparare la configurazione
della CompactFlash in maniera molto veloce.

Una volta avviato il programma basta scegliere Prepare Configuration Files, System ACE File,
System ACE CF e modalita Novice. Da qui in poi tutta la procedura é molto intuitiva. Dovremo
semplicemente indicare i file di design .bit (nella sottodirectory /implementation dei nostri progetti)
da associare a ciascuno degli 8 slot di memoria e copiare tutti i file e le directory create dal tool
nella root della Compact Flash tramite uno degli appositi card writer disponibili in commercio.

Ho allegato fra i miei files I'archivio cfboot.zip: copiando sulla compact flash il suo contenuto é
possibile caricare i files di configurazione ottenuti tramite il codice demo.c (configurazione degli
switch “111”) e videoelab.c (configurazione “110”).

Al’accensione della board il SystemACE legge lo stato degli switch e scarica il file di
configurazione nello slot di memoria associato. Qualora si volesse utilizzare un’altro file di
configurazione non occorre spegnere la board ma ¢é sufficiente cambiare lo stato degli switch e
premere il tasto RELOAD per aggiornare il sistema.
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6.0 RIFERIMENTI

Il materiale disponibile in rete per la MultiMedia Board é piuttosto scarso; si trovano on-line alcuni
tutorial per 'EDK, ma generalmente sono creati per 'utilizzo con altre board.

Sebbene tali tutorial possano essere molto utili, essi obbligano il novizio a fare molti esperimenti
prima di riuscire a far funzionare gli esempi su MultiMedia Board, specialmente quando si tratta di
utilizzare periferiche non troppo generiche come la ZBT RAM.

Alcuni tutorial si possono comunque trovare su:
http://support.xilinx.com/support/techsup/tutorials/index.htm
http://www.eece.unm.edu/xup

Gli unici esempi sviluppati specificatamente per MultiMedia board che sono riuscito a trovare, sono
reperibili all’indirizzo:

http://www.xilinx.com/products/boards/multimedia/examples.htm

Tali files sono testati perd su una vecchia versione dellEDK e danno non pochi problemi. |
cambiamenti fra una versione e l'altra dellEDK sono infatti sostanziali e generalmente ogni
progetto va riadattato di versione in versione.

Tutti i riferimenti tecnici sulla MultiMedia Board, 'EDK e i tools dell'lSE sono stati tratti dagli Help e
dalla documentazione fornita a corredo dei prodotti; essi sono comunque reperibili sul sito
http://www.xilinx.com; tale sito si rivela utile anche grazie al suo forum e un ricco Answer Database
in cui sono risolti i problemi tecnici piu frequenti.

Per quanto riguarda la documentazione relativa ai singoli cores, ricordo che essa pud essere
visualizzata dalla schermata principale del Platform Studio, cliccando con il tasto destro del mouse
sulla periferica desiderata e scegliendo View PDF Doc.

Seguono i riferimenti a cui si rimanda in vari punti del presente documento per approfondimento e
consultazione tecnica.

[1] Per la documentazione relativa al formato MHS ci si pud riferire al file est guide.pdf
(Embedded System Tools Guide, pag.197 e seguenti) richiamabile dal’Help del’EDK.

[2] Per quanto riguarda la connessione dei pin del’FPGA con la board si vedano le pagg.19-34
del file UG020.pdf presente nella directory MicroBlaze & Multimedia Demo Board User Guide
del cd contenente la documentazione fornito dalla Xilinx con la board. Sempre nello stesso cd,
nella directory FPGA IO Constraint Files, sono presenti i file relativi alle varie periferiche
(raggruppate per tipo) in formato UCF, pronti per l'uso.

Per quanto riguarda la sintassi del formato UCF si veda il documento:
http://toolbox.xilinx.com/docsan/xilinx5/pdf/docs/cgd/cgd.pdf

[3] Per la documentazione relativa alle librerie Xilinx ci si puo riferire al file xilinx_drivers.pdf
(Xilinx Device Drivers Documentation) richiamabile dall’Help dellEDK.

[4] Si veda iMPACT on-line help: Command Line and Batch Mode.
[5] Il file systemace.bsd é stato preso dal progetto
MicroBlaze Media_Brd IIC vidtest edk3 2 sp1.
Per informazioni sui file BSDL si veda 'Answer Record # 15346 presente sul sito della Xilinx.
[6] Si veda xilinx_drivers.pdf (pag.1063).
[7]1 Si veda xilinx_drivers.pdf (pag. 1041 e seguenti).
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[8] Si veda xilinx_drivers.pdf (pag. 1059 e seguenti).

[9] Si veda xilinx_drivers.pdf (pag. 1045).

[10] Si veda xilinx_drivers.pdf (pag. 528).

[11] Si veda xilinx_drivers.pdf (pag. 532).

[12] Si veda UG020.pdf (pagg.17-18).

[13] Si veda Documentation CD: Design Examples\CLOCK_GENERATION\CLOCKGEN.v.
[14] Si veda est_guide.pdf (pag.206 e seguenti).

[15] Si veda est_guide.pdf (pag.165 e seguenti).

[16] Si veda UGO020.pdf (pagg.15-17).

[17] Si veda Documentation CD: Board Schematics, 0381112r01.pdf.

[18] Si veda Documentation CD: directory CPLD Documentation Files

[19] Si veda UGO020.pdf (pagg.6-8).

Maggiori dettagli nel Documentation CD: directory Component Data Sheets, files
ADV7185_video_decoder.pdf e ADV7194 video_encoder.pdf.

[20] Si veda Documentation CD: directory /12C Register Values

[21] Si veda xilinx_drivers.pdf (pag. 524 e seguenti).

[22] Si veda UG020.pdf (pagg.13-15)

Maggiori dettagli nel Documentation CD:
Component Data Sheets\XCCACE_SystemACE_Controller.pdf
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